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Important User Information 
Read this document and the documents listed in the additional resources section about installation, configuration, and 
operation of this equipment before you install, configure, operate, or maintain this product. Users are required to familiarize 
themselves with installation and wiring instructions in addition to requirements of all applicable codes, laws, and standards. 

Activities including installation, adjustments, putting into service, use, assembly, disassembly, and maintenance are required to 
be carried out by suitably trained personnel in accordance with applicable code of practice. 

If this equipment is used in a manner not specified by the manufacturer, the protection provided by the equipment may be 
impaired. 

In no event will Rockwell Automation, Inc. be responsible or liable for indirect or consequential damages resulting from the use 
or application of this equipment. 

The examples and diagrams in this manual are included solely for illustrative purposes. Because of the many variables and 
requirements associated with any particular installation, Rockwell Automation, Inc. cannot assume responsibility or liability for 
actual use based on the examples and diagrams. 

No patent liability is assumed by Rockwell Automation, Inc. with respect to use of information, circuits, equipment, or software 
described in this manual. 

Reproduction of the contents of this manual, in whole or in part, without written permission of Rockwell Automation, Inc., is 
prohibited. 

Throughout this manual, when necessary, we use notes to make you aware of safety considerations. 

 
WARNING: Identifies information about practices or circumstances that can cause an explosion in a hazardous environment, which may lead to 
personal injury or death, property damage, or economic loss. 

 

 
ATTENTION: Identifies information about practices or circumstances that can lead to personal injury or death, property damage, or economic loss. 
Attentions help you identify a hazard, avoid a hazard, and recognize the consequence. 

 
IMPORTANT Identifies information that is critical for successful application and understanding of the product. 

Labels may also be on or inside the equipment to provide specific precautions. 

 
SHOCK HAZARD: Labels may be on or inside the equipment, for example, a drive or motor, to alert people that dangerous voltage may be present. 

 

 
BURN HAZARD: Labels may be on or inside the equipment, for example, a drive or motor, to alert people that surfaces may reach dangerous 
temperatures. 

 

 
ARC FLASH HAZARD: Labels may be on or inside the equipment, for example, a motor control center, to alert people to potential Arc Flash. Arc Flash 
will cause severe injury or death. Wear proper Personal Protective Equipment (PPE). Follow ALL Regulatory requirements for safe work practices and 
for Personal Protective Equipment (PPE). 

 
 



 

  3 
 

Table of Contents 

About this manual ....................................................................................... 9 
Legal Notices ............................................................................................... 9 
Additional resources ..................................................................................10 

Chapter 1 
Use hyperlinks ............................................................................................ 15 

Make internal documents available .................................................... 15 
Create a virtual directory............................................................... 16 
Assign the virtual directory to an equipment resource .............. 17 

Edit the user.asp ......................................................................................... 19 
Add a custom logo to the user.asp ...................................................... 19 
Add a greeting to the user.asp ............................................................. 21 

ActiveX controls .......................................................................................... 21 
Add ActiveX controls ............................................................................ 21 
Specify the timeout period .................................................................. 21 
Prepare the SignatureList control for Internet Explorer ................. 22 

Chapter 2 
FactoryTalk eProcedure communications .............................................. 25 
Create a shared directory ......................................................................... 25 
Use OLE for Process Control (OPC) ......................................................... 26 

OPC group support ............................................................................. 26 

Chapter 3 
Understand eProcedure security ............................................................. 27 

Configure the eProcedure service ...................................................... 27 
Add the Batch Server user account to the client computer .............. 28 

FactoryTalk Batch Client security ............................................................ 28 
Tighten security for FactoryTalk Batch Clients ................................ 29 
FactoryTalk Batch View security ........................................................ 30 
Change permissions on the BATCHCTL share ................................. 30 
Security for FactoryTalk Batch commands ........................................ 31 

Configure security for FactoryTalk Batch commands ................ 31 
Enable Batch View confirm settings ............................................ 33 

Chapter 4 
Windows services ...................................................................................... 35 
FactoryTalk Batch Service Manager dialog box ....................................... 36 

Connection ........................................................................................... 37 
Service state .......................................................................................... 37 

Preface 

Customize eProcedure 

Understand communications 

Implement security 

The FactoryTalk Batch Service 
Manager 



Table of Contents 
 

4   
 

Server ................................................................................................... 38 
FactoryTalk Batch Server Details dialog box ............................................ 39 

FactoryTalk Batch Server Details dialog box - General tab ............... 39 
FactoryTalk Batch Server Details dialog box - Messages tab ............ 39 
FactoryTalk Batch Server Details dialog box - PCD Communications 
tab ......................................................................................................... 40 
FactoryTalk Batch Server Details dialog box - View 
Communications tab .......................................................................... 40 

Start the FactoryTalk Batch Server service ............................................... 41 
FactoryTalk Batch Server overview .................................................... 42 
Sample demonstration setup .............................................................. 43 
Batch Service Manager dialog box - Server options .......................... 43 
Enable a grace period ........................................................................... 43 
Grace periods in FactoryTalk Batch Server ....................................... 44 
Add a custom service........................................................................... 44 

Chapter 5 
FactoryTalk Batch Server service configuration ..................................... 47 

Specify the startup type ....................................................................... 47 
FactoryTalk Batch Server option configuration...................................... 48 

Server Options dialog box - Project Settings tab .............................. 48 
Set project directories ................................................................... 49 
Configure recipe storage .............................................................. 50 
Recipe versioning .......................................................................... 50 

Server Options dialog box - Restart Control tab ............................... 50 
Redundant servers ......................................................................... 51 
Define redundant servers ............................................................. 51 

Server Options dialog box - Batch Reporting tab ............................. 52 
Report Editor .................................................................................. 53 
Perform end of batch archiving .................................................... 53 
Perform incremental archiving ....................................................54 
Perform user-defined end of batch .............................................. 55 
None ................................................................................................ 55 
Never ............................................................................................... 55 

Archiver Event Filters tab .................................................................... 55 
Batch Server tab ...................................................................................56 

Hold propagation ........................................................................... 57 
Communications timeout ............................................................. 57 
Miscellaneous ................................................................................ 58 
Batch identification ...................................................................... 58 

Cross Invocation Descriptors and Defaults tab .................................59 
Resource types ................................................................................59 

The FactoryTalk Batch Server 



Table of Contents 
 

  5 
 

Descriptors .....................................................................................59 
Default values ................................................................................ 60 

Hyperlink Descriptors and Defaults tab ........................................... 60 
Resource types ............................................................................... 60 
Descriptors .................................................................................... 60 
Default values ................................................................................. 61 

Material Policies tab ............................................................................. 61 
Option when Material Server comm is lost ................................ 62 
Hold on split feed .......................................................................... 62 

Modify the .NET registry key ..................................................................... 63 
Use automatic restart control to restart the FactoryTalk Batch Server . 63 

Restart the FactoryTalk Batch Server ................................................. 63 
Perform a manual failover ........................................................................ 64 

Configure the FactoryTalk Batch Server for manual failover .......... 64 
Configure the material-enabled FactoryTalk Batch Server for 
manual failover .....................................................................................65 

Command handshake timeout ................................................................. 66 

Chapter 6 
View event log entry properties ................................................................67 
Modify event log settings ......................................................................... 70 

Chapter 7 
Cross invocation overview ........................................................................ 73 
Cross invocation string configuration ..................................................... 74 
Cross invocation string escape sequences ............................................... 75 

Cross invocation string example ........................................................76 
FactoryTalk Batch View and ActiveX Controls configuration for 
cross invocation ............................................................................. 77 

Chapter 8 
Start the FactoryTalk Batch Phase Simulator ..........................................79 

FactoryTalk Batch Phase Simulator interface ................................... 80 
Phase Configuration dialog box .............................................................. 80 

Change the dwell time ......................................................................... 81 
Change the sequence of requests ........................................................ 81 
Indicate a continuous phase .............................................................. 82 

Phase Status dialog box ............................................................................ 82 
View phase parameter tag values ....................................................... 83 
View and update report parameter tag values .................................. 83 
Phase commands ................................................................................ 83 

Command a phase ........................................................................ 84 

Windows event log 

Cross invocation 

The FactoryTalk Batch Phase 
Simulator 



Table of Contents 
 

6   
 

Change ownership of a phase ............................................................ 85 
Acknowledge and clear a request ....................................................... 85 
Restore and clear requests .................................................................. 85 
View request data tag values .............................................................. 86 

Unit Tag Status dialog box ........................................................................ 86 
Change the value of a unit tag ............................................................ 87 

Chapter 9 
Troubleshooting eProcedure.................................................................... 89 

Objects embedded in HTML code do not display ............................. 89 
Control step reactivation error messages ......................................... 89 

Troubleshooting FactoryTalk Batch ......................................................... 90 
Handle abnormal FactoryTalk Batch termination ........................... 90 

Determine abnormal termination ................................................ 91 
Name the log file copy ................................................................... 91 
End of batch entries ...................................................................... 92 

Log tag verification information ....................................................... 92 
Tag verification log file .................................................................. 93 
Windows event log......................................................................... 93 

Performance chart .............................................................................. 94 
Open the FactoryTalk Batch performance chart ........................ 94 
FactoryTalk Batch performance chart ..........................................95 

Troubleshoot errors .............................................................................95 

Chapter 10 
Enable editing of batch IDs ..................................................................... 101 
Disable editing of batch IDs ....................................................................102 
Define a custom default batch ID ...........................................................102 
Create a custom BatchIDCreation.dll .....................................................102 
Modify the user.asp file to allow editing of batch IDs ........................... 104 
Modify the user.asp file to prevent editing of batch IDs ....................... 105 

Chapter 11 
HTML elements ........................................................................................ 109 

Chapter 12 
New user account requirements for the FactoryTalk Batch Server ......113 
Configure your FactoryTalk Batch system ..............................................113 

Change the server account password ............................................... 114 
Change the server user account for the FactoryTalk Batch Server 
service ................................................................................................. 115 

Troubleshooting 

Customize batch IDs 

Archive HTML elements 

Change the FactoryTalk Batch 
server user account 



Table of Contents 
 

  7 
 

Change the server user account in FactoryTalk Batch COM+ 
applications ........................................................................................ 116 
Change the server user account in My Computer properties ......... 116 
Configure your FactoryTalk Batch system ........................................117 
Server account password change locations ..................................... 118 

  Index 





 

  9 
 

Preface 

This guide contains instructions for procedures specific to FactoryTalk 
eProcedure®, such as implementing security and configuring the user-defined 
area active server page.It is one of a set of related manuals that describe 
installing, programming, and operating the FactoryTalk Batch system.  

Included are instructions for tasks specific to FactoryTalk® Batch, such as 
configuring security and services to support eProcedure. Instructions are also 
provided on the implementation and use of components not normally 
accessed or used by batch operators, such as the FactoryTalk Batch Server, 
Simulator, and performance chart. 

To review FactoryTalk Batch release notes and latest information regarding 
product compatibility refer to the Product Compatibility and Download 
Center (PCDC). 

 

 

Rockwell Automation publishes legal notices, such as privacy policies, license 
agreements, trademark disclosures, and other terms and conditions on the 
Legal Notices page of the Rockwell Automation website. 

End User License Agreement (EULA) 

You can view the Rockwell Automation End User License Agreement (EULA) 
by opening the license.rtf file located in your product's install folder on your 
hard drive.  

The default location of this file is: 

C:\Program Files (x86)\Common Files\Rockwell\license.rtf 

Open Source Software Licenses 

The software included in this product contains copyrighted software that is 
licensed under one or more open source licenses.  

You can view a full list of all open source software used in this product and 
their corresponding licenses by opening the oss_license.txt file located your 
product's OPENSOURCE folder on your hard drive. This file is divided into 
these sections: 

• Components 
Includes the name of the open source component, its version number, 
and the type of license. 

About this manual 

Legal Notices 

http://www.rockwellautomation.com/global/support/pcdc.page
http://www.rockwellautomation.com/global/support/pcdc.page
https://www.rockwellautomation.com/global/legal-notices/overview.page


Preface 

10 

• Copyright Text 
Includes the name of the open source component, its version number,
and the copyright declaration. 

• Licenses 
Includes the name of the license, the list of open source components
citing the license, and the terms of the license. 

The default location of this file is: 

C:\Program Files (x86)\Common Files\Rockwell\Help\<product 
name>\Release Notes\OPENSOURCE\oss_licenses.txt  

You may obtain Corresponding Source code for open source packages 
included in this product from their respective project web site(s). 
Alternatively, you may obtain complete Corresponding Source code by 
contacting Rockwell Automation via the Contact form on the Rockwell 
Automation website: http://www.rockwellautomation.com/global/about-
us/contact/contact.page. Please include "Open Source" as part of the request 
text. 

Following is a comprehensive list of documentation for the FactoryTalk® 
Batch products from Rockwell Automation. 

Installation, Quick Start, and Getting Results Guides 
Resource Description 

FactoryTalk Batch Components Installation and 
Upgrade Guide 
(BATCH-IN002) 

Provides information and procedures for FactoryTalk 
Batch system installation. Includes information for 
FactoryTalk Batch Material Manager, FactoryTalk Event 
Archiver, and associated FactoryTalk Batch Client and 
Server components. 

FactoryTalk Batch View Quick Start Guide 
(FTBVS-QS001) 

Provides information about using FactoryTalk Batch View 
to create, view, and command control recipes, 
acknowledge prompts and signatures, view equipment 
phases and diagnostic information, and view profile 
information.  

FactoryTalk Batch View HMI Controls Quick Start 
Guide 
(BATCH-QS001D) 

Provides a general overview of FactoryTalk Batch View 
HMI Controls. 

FactoryTalk Batch eProcedure® Getting Results 
Guide 
(BWEPRO-GR011) 

Explains the basics of FactoryTalk Batch eProcedure. 

FactoryTalk Batch Getting Results Guide 
(BATCH-GR011) 

Introduces the basics of automated batch manufacturing 
and the FactoryTalk Batch product components. 

FactoryTalk Batch Material Manager Getting 
Results Guide 
(BWMTR-GR011) 

Introduces the basics of FactoryTalk Batch Material 
Manager. 

Additional resources 

http://www.rockwellautomation.com/global/about-us/contact/contact.page
http://www.rockwellautomation.com/global/about-us/contact/contact.page
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User Guides 
Resource Description 

FactoryTalk Batch ActiveX Controls User Guide 
(BATCH-UM013) 

Provides information and instructions for using the 
FactoryTalk Batch ActiveX Custom Controls. 

FactoryTalk Batch Material Editor User Guide 
(BWMTR-UM001) 

Provides access to information and procedural 
instructions required to configure materials and the 
containers to hold them. The material data is stored in the 
material database, which is used to create material-
based recipes. This information is intended as a 
reference for the formulator. 

FactoryTalk Batch Equipment Editor User Guide 
(BATCH-UM004) 

Provides information on creating and maintaining an 
equipment database (area model). The area model is 
stored in a file with a .cfg file extension and is available 
to all other FactoryTalk Batch programs, including the 
Recipe Editor, View, and Phase Simulator. 

FactoryTalk Batch PhaseManager™ User Guide 
(BATCHX-UM011) 

Describes the integration of the FactoryTalk Batch 
software with the Studio 5000 Logix Designer® 
application and the Logix 5000™ family of controllers. 
The integration simplifies the configuration and 
maintenance of the FactoryTalk Batch automation 
system, provides better communication between the 
FactoryTalk Batch Server and the Logix 5000 controller, 
and significantly reduces the programming effort 
required to develop the phase logic code that resides in 
your Logix 5000 controller. 

FactoryTalk Batch Recipe Editor User Guide 
(BATCH-UM006) 

Provides instructions on using FactoryTalk Batch Recipe 
Editor to create and configure master recipes for use in 
batch automation. The interface is based on IEC 61131-3 
sequential function charts to graphically organize recipes 
into procedures, unit procedures, operations, and phases. 
Build recipes using either the SFC format or a table-based 
format. 

FactoryTalk Batch View HMI Controls User Manual 
(FTBVS-UM003) 

Provides details about using FactoryTalk Batch View HMI 
Controls to monitor and interact with the production 
process within a FactoryTalk View SE Display Client.  

FactoryTalk Batch View User Manual 
(FTBVS-UM002) 

Provides information and procedural instructions for 
using FactoryTalk Batch View in a modern and intuitive 
portal into a comprehensive batching solution for 
effective operations, leveraging its own web server using 
HTML5 technology to provide native connectivity into a 
FactoryTalk Batch Server.  

FactoryTalk eProcedure Client User Guide 
(BWEPRO-UM001) 

Provides information and procedural instructions 
required to create and command batches using the 
FactoryTalk eProcedure Client, and can be used as a 
reference information by the operator. 

FactoryTalk Event Archiver User Guide (BATCH-
UM012) 

Provides information and instructions specific to the 
FactoryTalk Event Archiver. Intended for use by the 
system administrator and production supervisor.  
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Resource Description 

FactoryTalk Batch View User Guide (legacy) 
(FTBVS-UM001) 

Provides information and instructions on how to use 
FactoryTalk Batch View to initiate and execute 
FactoryTalk Batch automation processing. FactoryTalk 
Batch View secured objects are located in the FactoryTalk 
Diagnostics and are modified using the FactoryTalk 
Administration Console. A system administrator can 
customize FactoryTalk Batch View security to meet the 
needs of the facility. FactoryTalk Batch View is used in 
conjunction with a Human-Machine Interface (HMI). 

Administrator Guides 
Resource Description 

FactoryTalk Batch Administrator Guide 
(BATCH-UM003) 

Provides instructions for configuring security and 
services, and implementation and use of components not 
typically accessed or used by batch operators, such as 
the FactoryTalk Batch Server. 

FactoryTalk Batch eProcedure Administrator Guide 
(BWEPRO-UM011) 

Provides procedures specific to FactoryTalk Batch 
eProcedure, such as implementing security and 
configuring the user-defined area Active Server Page. 
Included are instructions for tasks specific to FactoryTalk 
Batch, such as configuring security and services to 
support FactoryTalk Batch eProcedure. Provides 
instructions on the implementation and use of 
components not typically accessed or used by batch 
operators, such as the FactoryTalk Batch Server. 

FactoryTalk Batch Material Manager Administrator 
Guide 
(BWEPRO-UM011) 

Provides information and instructions specific to 
FactoryTalk Batch Material Manager. Intended for use by 
the system administrator and database administrator. 

Reference Guides 
Resource Description 

FactoryTalk Batch ActiveX Controls Library 
Reference Guide 
(BATCH-RM001) 

Provides reference information and procedural 
instructions for the FactoryTalk Batch ActiveX Custom 
Controls. 

FactoryTalk Batch Material Server API Technical 
Reference 
(BWMTR-RM001) 

Provides access to information regarding the interface 
between the FactoryTalk Batch Material Server and the 
FactoryTalk Batch Material Editor and FactoryTalk Batch. 
It is intended to be used as a reference information by 
those who want to develop custom interfaces. 

FactoryTalk Batch PCD Programming Reference 
Manual 
(BATCH-RM004) 

Provides information and instructions about the 
FactoryTalk Batch PCD interface design. It is intended to 
be used as a reference guide. 

FactoryTalk Batch Server API Reference Manual 
(BATCH-RM003) 

Provides information regarding the interface between the 
FactoryTalk Batch Server and FactoryTalk Batch View — 
the Server Application Programming Interface (API). It is 
intended to be used as a reference guide by those who 
want to develop custom interfaces. 
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Resource Description 

FactoryTalk Batch System Files Reference Manual 
(BATCH-RM005) 

Provides the technical information for configuration and 
maintenance of a FactoryTalk Batch system. It can be 
used as a reference information for implementation 
engineers and the system administrator. 

FactoryTalk Batch eProcedure Instruction File 
Design Reference Manual 
(BWEPRO-RM001) 

Includes information about the building of instruction 
files for use in equipment database creation and recipe 
development. This information is intended to be used as a 
reference by the instruction file author. 

View or download publications at 
http://www.rockwellautomation.com/literature. To order paper copies of 
technical documentation, contact your local Allen-Bradley® distributor or 
sales representative. 

http://www.rockwellautomation.com/literature
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Chapter 1 

Customize eProcedure 

eProcedure is used to display hyperlinks associated with equipment resources 
and to customize the appearance of the eProcedure Client. Hyperlinks are 
assigned to equipment resources within the FactoryTalk Batch Equipment 
Editor. The eProcedure Client is customized by editing the User.asp file. A 
company logo and Internet URL can be added; batch IDs can be made editable 
or not. The URL can point to an intranet site containing maintenance records 
or material safety documents.  

 

You can use any valid URL to view web pages from the Equipment view, but 
you can also configure hyperlinks for internal documents such as 
maintenance history logs, maintenance schedules, personnel schedules, notes 
about operations, web camera views of units or equipment, and startup or 
shutdown documentation. 

Once the URL of a document (or web camera) is configured, you can view the 
item through the browser. You can use the Back or Home button to return to 
the Equipment view. 

Hyperlinks can be assigned to any resources within the equipment database. 
These hyperlinks are then made available within the eProcedure Client in the 
Equipment view. You can use the hyperlinks to provide access to documents 
that reside on your local intranet, pertaining to the specific equipment 
resource, or you may want to provide access to a manufacturer’s web site. The 
following instructions outline the method for making internal documents 
available via hyperlinks. 

 

In order to make documents or items accessible from within the FactoryTalk 
Batch Client, you must first create a virtual directory that points to the 
directory containing the documentation or image files. 

A virtual directory is a directory not physically contained within the home 
directory (/Inetpub) on the Web server. Virtual directories give you the ability 
to publish information located on your hard drive. For example, if you create a 
virtual directory for C:\Documents\Reports and give it an alias of Reports, users 
could view the directory using the URL Error! Hyperlink reference not valid.. 

 

Use hyperlinks 

Make internal documents 
available 
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You must be logged on as a member of the Administrators group on the local 
computer to perform the following procedures.  

To create a virtual directory: 
1. Ensure that Internet Information Services are enabled, then open 

Internet Information Services (IIS) Manager. 
2. In the Connections pane, expand the Sites node in the tree, and then 

navigate to Default Web Site. 
3. In the Actions pane, click View Virtual Directories. 
4. On the Virtual Directories page, in the Actions pane, click Add Virtual 

Directory. 
5. In the Add Virtual Directory dialog box, type a name in the Alias text 

box. This alias is used to access the content from a URL. 
6. In the Physical path text box, type the physical path of the content 

folder, or click Browse(...) to navigate through the file system to find 
the folder. 

7. Click OK. 

This creates a virtual directory within your default web directory. See 
Microsoft’s online help for Internet Information Services (IIS) for more 
information on virtual directories. 

Important: When you click OK in the Edit Alias dialog box, your changes take 
effect immediately. Clicking Cancel does not cancel the alias 
assignment. 

Virtual Directory Examples 
Example 1: 

• You want to create a virtual directory called Reports. The actual 
directory is C:\Reports. Using the steps above, the virtual directory is 
created under the default web site. 

The hyperlink in the Equipment Editor is: /REPORTS/<file name> 

• You want to create a virtual directory called Pictures for custom icons to 
reference from an instruction file. The actual directory is C:\Pictures. 
Using the steps above, the virtual directory is created under the default 
web site. 

The file reference in an instruction file form is: img 
src=/Pictures/<picture.gif> 

Example 2: 

• You want to create a virtual directory called Reports in the eProcedure 
virtual directory. The actual directory is C:\Program Files\Rockwell 
Software\Batch\Reports. In step 5 above, enter the alias 
/eProcedure/Reports. 

The hyperlink in the Equipment Editor is: REPORTS/<file name> (no 
preceding slash). 

Create a virtual directory 
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• You want to create a virtual directory called Pictures in the eProcedure 
virtual directory. The actual directory is C:\Program Files\Rockwell 
Software\Batch\Pictures. In step 5 above, enter the alias 
/eProcedure/Pictures. 

The file reference in an instruction file form would be: img 
src=Pictures/<picture.gif> (no preceding slash). 
 
 

Follow the instructions in the FactoryTalk Batch Equipment Editor User Guide for 
setting up an equipment resource. The Server Options dialog box contains 
some or all of the tabs on the following screen shots, depending on which 
FactoryTalk Batch modules are installed on your system. 

1. Open the Equipment Editor. 
2. From the Options menu, click Server Options, and then select the 

Hyperlink Descriptors and Defaults tab. 

 
3. Select the desired resource type (this example uses Equipment 

Modules). 
4. In the Descriptors area, type a descriptive name for each hyperlink you 

want to associate with an equipment module. The example in the 
figure above lists possible names. 

5. If necessary, type or change the information listed in the Default 
Values boxes. 

6. Click OK. 
7. Navigate to the desired equipment module and right-click to display 

the Edit Equipment Module dialog. 

Assign the virtual directory 
to an equipment resource 
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8. Select the Hyperlink tab. 

 
9. In the Hyperlink Configuration area, type each hyperlink. For the 

example shown above, you would type 
http://Server_Name/Reports/<doc_name>, where <doc_name> is the 
desired HTML file to display. 

10. Click OK when done. Stop and restart the FactoryTalk Batch Server 
and eProcedure Server services (if Warm Restart is not selected in the 
FactoryTalk Batch Service Manager). When the equipment module is 
used in a batch and viewed in eProcedure, the hyperlink is displayed to 
the right of the equipment module icon, as shown below. 

 
11. When you click the hyperlink, the specified web page opens (see the 

example below). To return to eProcedure, click the Back button on the 
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browser toolbar. Notice how the URL displays in the remote Client’s 
Address box. 

 
 
 

The User.asp file is located in the \Program Files\Rockwell Software\Batch\web 
directory on the FactoryTalk Batch Server computer. You can modify this file 
to support requirements specific to your system. For example, you could add 
HTML code to the User.asp that links eProcedure to displays of other 
manufacturing applications, such as status information from a SCADA 
(supervisory control and data acquisition) system. The User.asp can be 
modified so that documents are always available (because they are not related 
to specific equipment). You can also modify the User.asp to specify a timeout 
period for the Batch List ActiveX control. (For more information on specifying 
the timeout period, see Specifying the timeout period on page 21 later in this 
chapter.) 

Important: Do not edit any ASPs other than User.asp. They are directly related to the successful 
operation of eProcedure. 

Other documents could be maintenance schedules, quality lab schedules, 
personnel shift schedules, pages for e-mail sent to the area, or web mail e-mail 
sender pages (to allow the operator to send e-mail from the area). You could 
even point them to stock pages, where the company’s stock price and press 
releases are posted. You could also add HTML that displays buttons linking to 
other manufacturing applications like an HMI or LIMS (laboratory 
information management systems). 

 

This example discusses how to add a custom logo and link to a web site to the 
User.asp. 

Tip: Images and files must be placed in directories under \Batch\web\ to use relative 
("./") paths. Otherwise, absolute path names must be used (for example, 
"/full_path/Image.jpg"). 

1. Open User.asp in a text Editor such as Notepad and save it with the 
name User.old. This allows you to recover the original file should you 
need it. 

2. Open the original User.asp file. 

Edit the user.asp 

Add a custom logo to the 
user.asp 



Chapter 1  Customize eProcedure 
 

20   
 

3. Locate the line that is highlighted in the file (as shown below). 

 
4. Edit this line with the desired information: 

• The new URL  
For example: http://www.acmecorp.com/safetydocs.html 

• The text to use when the mouse moves over the logo (Alt) 
For example: IMG alt="Acme Corp" 

• The name of the new logo image (.gif or .jpg) 
For example: src="./images/acmelogo.gif" (if the image has been 
copied to the \Program Files\Rockwell Software\Batch\web\images 
directory) 

or src="/fullpath/acmelogo.gif" (if the file is located outside the 
\Program Files\Rockwell Software\Batch\web\images directory) 

The new file should resemble the figure below: 

 
5. Save the file as User.asp. Exit the text editor. 
6. Open eProcedure to verify that the changes take place. The new 

eProcedure opening page should resemble the image below. Note the 
mouse over text and the URL in the status bar at the bottom of the 
window. 
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You can even add logic to the User.asp. The following example adds a greeting 
based on the time of day. 

 

If a user logs onto the eProcedure Client after midnight and before noon, the 
greeting is "Good Morning!" At any other time the user is greeted with "Hello!" 

 

eProcedure uses ActiveX controls to communicate with the FactoryTalk Batch 
Server and allows you to monitor and interact with control recipes. These 
controls are necessary for the correct operation of the program. You can 
specify the timeout period for the batch list ActiveX control to allow for larger 
batches to be put on the batch list without timing out. You can also embed 
additional ActiveX controls in HTML recipe forms containing SOPs, which 
gives you even more flexibility when running a batch recipe with eProcedure. 

 

All controls must occur within a form in the instruction file or eProcedure 
ignores the script. When creating an HTML file, the form is designated by the 
<Form></Form> tags. (See the FactoryTalk eProcedure Instruction File Design 
Guide for information on creating instruction files.) 

 

In the User.asp file, you can specify the timeout period for the BatchList 
ActiveX control. The default value is 60000 milliseconds, which equals 60 
seconds. If batch creation is taking longer than 60 seconds, you can increase 

Add a greeting to the 
user.asp 

ActiveX controls 

Add ActiveX controls 

Specify the timeout period 
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the value as needed. The following example highlights the line you must 
modify in the User.asp file. 

 

 

For the SignatureList control to work in any client application, including the 
eProcedure Client, that does not call CoInitializeSecurity (this includes 
Internet Explorer, Visual Basic, and possibly HMI applications), the following 
steps must be completed on the client computer: 

1. If the FactoryTalk Batch Server runs under a local machine account 
(workgroup), create an account with the same user name and 
password on the client machine. 

2. Navigate to Administrative Tools and select Component Services. The 
Component Services window opens. 

 
3. Expand Component Services and Computers, right-click My 

Computer, and then select Properties. The My Computer Properties 
dialog box opens. 

 

Prepare the SignatureList 
control for Internet Explorer 
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4. Click the [Default] COM Security tab, and then click the Edit Default 
button in the Access Permissions area. The Access Permission dialog 
box opens. 

 
5. Click the Add button. The Select Users, Computers, or Groups dialog 

box opens. 

 
6. Select the correct location in the From this location box: 

• If the FactoryTalk Batch Server is running on a domain, select the 
Server domain name. 

• If the FactoryTalk Batch Server is running on a local user account 
(workgroup), select the Client computer name. 

7. In the Enter the object names to select box, add the account the 
FactoryTalk Batch Server runs as to the list and click Check Names. 
This verifies that the account exists. 

• If the FactoryTalk Batch Server is running on a domain, choose the 
Server’s domain account (for example, batchsvr). 
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• If the FactoryTalk Batch Server is running on a local user account 
(workgroup), select the name of the local account under which the 
Server runs. 

 
8. Select the new user or group in the Group or user name area and, in 

the Permissions area, set Access Permission to Allow (Windows Server 
2008) or Local Access and Remote Access to Allow (Windows 7 or XP). 

 
9. Click OK to close the Access Permission and My Computer Properties 

dialog boxes. 
10. Close the Component Services window. 
11. Log off and then log back on. 
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Chapter 2 

Understand communications 

FactoryTalk eProcedure itself requires very little in the way of special 
configuration. Most of the required configuration is performed in the post-
installation procedures. (See the FactoryTalk eProcedure Getting Results Guide for 
more information.) The information in this section is provided to enhance 
your understanding of how eProcedure works in conjunction with 
FactoryTalk Batch.  

 

eProcedure uses OLE for Process Control (OPC) to communicate between the 
eProcedure Server and the FactoryTalk Batch Server. Communication from 
the eProcedure Client to the Server is HTTP (for web content) and DCOM for 
live data. 

 

 

A shared directory allows computers on the network to read from and write to 
a common recipe, area model, or data file. The FactoryTalk Batch installation 
creates a shared directory named BATCHCTL where the FactoryTalk Batch 
software is installed (the default is C:\Program Files (x86)\Rockwell 
Software\Batch). If you installed your project files in a different directory, 
configure that directory as a shared directory. To configure a shared directory, 
administrative privileges are required. 

Client Computer
eProcedure  

Server

Batch Server DCOM

Server Computer

HTTP 
& 

DCOM

OPC

Ethernet (TCP/IP)

eProcedure  Client

FactoryTalk eProcedure 
communications 

Create a shared directory 
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To create a shared directory: 
1. Navigate to the project file directory, then right-click the folder, and 

select the sharing option.  
2. Use the File Sharing dialog box to add each user or user group name 

that requires access to the project file directory. 
3. Repeat for each user or user group, including the user accounts used 

by the FactoryTalk Batch Server and FactoryTalk Event Archiver. 
4. Select Share. 

 

The FactoryTalk Batch Server supports the use of the OLE for Process Control 
(OPC) communications protocol. OPC provides a defined set of COM 
interfaces for data access functions. 

The OPC communications protocol is used by the FactoryTalk Batch Server to 
communicate with process-connected devices via a data server and to 
communicate with FactoryTalk Batch View, SignatureList ActiveX control and 
PC-Based phases. COM is used to communicate with ActiveX controls or other 
high-level applications such as FactoryTalk Batch Material Manager. 

 

Within the OPC protocol, data is accessed through collections of data items 
referred to as groups. Different data servers have varying levels of OPC 
support, including maximum numbers of groups, maximum numbers of 
items per group and performance issues, and so on. Because of this, 
FactoryTalk Batch support of OPC is flexible in order to achieve successful 
communication with as many different data servers as possible. To achieve 
this, the FactoryTalk Batch Server is flexible in its definition of Groups, and 
allows for different OPC grouping configurations to communicate with the 
data server(s). 

The manner in which the FactoryTalk Batch Server organizes the area model 
tags into groups is defined by data server definition files (DSDF). These files 
are located in the Batch\Dataservers directory. FactoryTalk Batch comes with 
a predefined set of DSDF files. If you need to communicate with a data server 
for which there is no predefined DSDF file, contact Rockwell Automation 
Application Support. 

 
 

Use OLE for Process Control 
(OPC) 

OPC group support 
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Chapter 3 

Implement security 

FactoryTalk eProcedure takes advantage of the security features of the 
FactoryTalk Batch View. The permissions assigned to the users and groups for 
the View commands are used within the eProcedure Client. The security 
implemented for the View is also used within the eProcedure Client. (See the 
FactoryTalk Batch Administrator Guide for more information.) 

The logged in user should: 

• be an FactoryTalk Security user or a Windows-linked user 
• be a user with rights to all of the buttons 

If operators wish to perform a function that is secured, for instance Abort, 
they must enter a user name and password, which is checked against the 
FactoryTalk Security settings defined in the FactoryTalk Directory. (See the 
FactoryTalk Batch Administrator Guide for more information.) 

Important: It is important to know that FactoryTalk Security cannot be used to secure 
eProcedure instructions. However, instructions can be secured through 
verification signatures. 

 
 

There are distinct differences between the security capabilities of the 
FactoryTalk eProcedure Client and the FactoryTalk Batch View: 

• Command buttons in the eProcedure Client are shown, but disabled, if 
the user does not have the appropriate permissions. 

• The Reactivate Step button on the Instructions view of the eProcedure 
Client and the ReactivateStep Confirm policy setting in FactoryTalk 
Directory are specific to eProcedure. 
Tip: Because the ability to secure FactoryTalk eProcedure instruction files does not currently 

exist in FactoryTalk Security, you can require an electronic signature on Parameter Change 
to prevent unauthorized users from executing instructions. (See Electronic signatures in 
the FactoryTalk Batch Equipment Editor User Guide for more information.) 

 
 

The eProcedure Service is installed on the FactoryTalk Batch Server computer 
and requires no special configuration. The eProcedure Service can be 
configured to start manually by changing the startup type in the Services 
dialog box of the Control Panel. (See the FactoryTalk Batch Administrator Guide 
for more information.) 

Understand eProcedure 
security 

Configure the eProcedure 
service 
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If the Batch Server user account is a workgroup account or if the FactoryTalk 
Batch Server computer needs to access files on the client computer, you must 
add the Batch Server user account to all FactoryTalk Batch client computers. 
(See the FactoryTalk Batch Administrator Guide for more information.) 

FactoryTalk Batch View, FactoryTalk eProcedure, ActiveX controls, 
Equipment Editor, and Recipe Editor use FactoryTalk Security, which allows 
security settings to be shared among FactoryTalk enabled products across a 
network or on the same computer. FactoryTalk Directory is the infrastructure 
which contains the security policies defined for FactoryTalk Security secured 
resources. 

FactoryTalk Batch secured resources include Batch Commands, Phase 
Commands, the Batch View windows, and log ons to FactoryTalk Batch 
components. For a complete list of FactoryTalk Batch secured objects and 
their default security policy settings refer to the FactoryTalk Batch Administrator 
Guide. 

FactoryTalk Batch product policies are created in the Local Directory and the 
Network Directory when the FactoryTalk Services Platform installs. The 
FactoryTalk Batch product polices are used to restrict access to the 
FactoryTalk Batch client components and the features within them. (See the 
FactoryTalk Help for more information.) 

The FactoryTalk Services Platform installation process: 

• Creates both a FactoryTalk Local Directory and a FactoryTalk 
Network Directory on the computer. When the install process 
finishes, both directories are fully configured and ready for use. 
Tip: Security settings are completely separate in the Network Directory and Local Directory. 

Changes you make to the security settings in the Network Directory do not affect the Local 
Directory and vice versa. 

• Allows any Windows Administrator user account to log on to either 
directory. The installation process automatically adds the local 
Windows Administrators group to the FactoryTalk Administrators 
group in each FactoryTalk Directory. 

• Allows any authenticated Windows user to log on to the FactoryTalk 
Local Directory. The installation process automatically adds all 
members of the local Windows Authenticated Users group to the 
FactoryTalk Local Directory. 

• Allows all new user accounts full access permissions. The installation 
process automatically sets system policies to allow all new user 
accounts added to either directory full access to that directory by 
default. 

 
  

Add the Batch Server user 
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Restrict access to specific features of your individual FactoryTalk products. 
Only users with access can use secured product features.  

For example, when you set up product policies for FactoryTalk Batch, restrict 
use of the Abort command to specific users. This prevents automated batch 
processes from going down during run time.  

To configure security for multiple features in FactoryTalk, use the Feature 
Security for Product Policies dialog box.  

To configure security for the FactoryTalk Batch features, refer to the secured 
product policies defined for the FactoryTalk Batch Clients.  

To tighten security for FactoryTalk Batch Clients: 
• Delete the Windows Authenticated Users group from the Local 

Directory. Secure the FactoryTalk Batch Configuration Options 
product policies in the Local Directory to avoid tampering or 
unauthorized changes.  

• Create new FactoryTalk user accounts and groups in the FactoryTalk 
Directory. Create user accounts or groups to secure the FactoryTalk 
Batch Clients.  

• Add user accounts and groups created in Windows to the FactoryTalk 
Directory. Windows accounts added to the FactoryTalk Directory are 
called Windows-linked user accounts and groups.  

IMPORTANT Windows Workgroup User Accounts are not supported in FactoryTalk. 
If you use Windows workgroups, you cannot administer user accounts 
centrally for FactoryTalk Batch Client applications. FactoryTalk Directory does 
not allow multiple user accounts to have the same name and password. 

• Remove the All Users group from the FactoryTalk Batch product 
policies. The FactoryTalk Services Platform installation process adds 
the All Users group to all FactoryTalk product policies. To secure 
FactoryTalk Batch, remove r restrict the All Users group for 
FactoryTalk Batch product policies. For example, to restrict access to 
FactoryTalk Batch View windows, remove the All Users group from the 
associated product policies and then add the necessary user accounts.  

• Add user accounts and groups to the FactoryTalk Batch product 
policies. To secure FactoryTalk Batch resources, add only the necessary 
user accounts and groups to the corresponding product policies. For a 
complete list of FactoryTalk Batch product policies, see FactoryTalk 
Batch default policy settings. 

  

Tighten security for 
FactoryTalk Batch Clients 
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This section describes the legacy FactoryTalk Batch View Windows desktop 
application.  

 
Tip: The modern FactoryTalk Batch View is an innovative and intuitive user interface for your 
comprehensive batch solution. It leverages state-of-the-art web technologies with scalable 
graphics for consistent visualization across all devices and form factors. The zero-install browser 
simplifies administration and maintenance. As the only native client application that supports the 
new features in FactoryTalk Batch and eProcedure, it is the client of the future for modern batch 
solutions.  
For more information about the new FactoryTalk Batch View mobile solution, view the FactoryTalk 
Batch View User Manual (FTBVS-UM002). 

Configure FactoryTalk security to specify which FactoryTalk Batch View 
toolbar buttons and windows are available to each logged on user. Removing a 
user group from a security policy disables the corresponding toolbar button 
for all users who are members of that user group. When a button is disabled, it 
no longer appears on the toolbar. 

Restrict access to resources based on where a user is physically located, such 
as a computer used to perform actions. (For more information, see 
FactoryTalk Help.) 

To open FactoryTalk Help, select Start > Rockwell Software > FactoryTalk 
Help. 

 

Change the permissions on the BATCHCTL share to tighten security by 
removing the Everyone group and adding a new group that contains all the 
Windows users that need to access the share.  

IMPORTANT This new group allows applications to access the BATCHCTL share while locking out 
non-domain users. 

Include these user types in the group: 

• The FactoryTalk Batch Server and FactoryTalk Event Archiver user.  
• Windows users logged in when the FactoryTalk Batch Equipment 

Editor, FactoryTalk Batch Recipe Editor and FactoryTalk Batch View 
are launched.  

To change permissions on the BATCHCTL share 
1. In Windows Explorer, locate the Batch folder. The default location is 

C:\Program Files (x86)\Rockwell Software\Batch. 
2. Right-click the Batch folder, and then select Properties. 
3. Select the Security tab and do the following: 

a. Select Edit, select the Everyone group, and then select Remove. 

b. After removing the Everyone group, select Add. 

FactoryTalk Batch View 
security 

Change permissions on the 
BATCHCTL share 
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4. From the Select Users, Computers, Service Accounts, or Groups dialog 
box, select Advanced and then click Find Now. 

5. Select a group from the Search results list, and then select OK. 
6. Select OK to return to the Properties dialog box. 
7. From the Group or user name list, select a user or group, and then 

select the permissions in the Permissions area. Repeat for each user or 
group. 

8. Select OK. 

 

Configure FactoryTalk Security to require user confirmation for batch 
commands and phase commands. A command that has the confirm feature 
enabled does not execute until the user account is validated in the Log on to 
Confirm User dialog box. 

To enable the Confirm feature, configure the FactoryTalk Batch product policy 
for the command and then set the associated <Command> Confirm policy 
setting to True. These policy settings are defined in FactoryTalk Directory for 
each command button within FactoryTalk Batch View and every phase 
command issued from the Phase Control window. 

 
Tip: When the Confirm feature is enabled for a command, only active user accounts assigned to the 
Command are allowed to execute the command. Users validated in the Log on to Confirm User 
dialog box are not logged on to FactoryTalk Batch View. 

The <Command> Confirm policy settings are found in the following locations: 

• FactoryTalk Directory\Local | Network\System\Policies\Product 
Policies\Batch\BatchView and ActiveX\Commands 

• FactoryTalk Directory\Local | Network\System\Policies\Product 
Policies\Batch\BatchView and ActiveX\Phase Commands 

 

To allow only specified users to issue commands against a batch or a phase, 
add the appropriate users or user groups to the Command or Phase 
Command policy setting. Then remove or restrict the All Users group. 

To configure security for FactoryTalk Batch commands: 
1. Open the FactoryTalk Administration Console and log on to the 

appropriate FactoryTalk Directory. 
2. Expand System > Policies > Product Policies > Batch > BatchView & 

ActiveX. 

Security for FactoryTalk 
Batch commands 

Configure security for 
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3. Right-click Commands and then select Properties. 

 
4. Select the policy setting to configure and then select the corresponding 

browse button. 
5. (optional) In the Configure Securable Action dialog box: 

• Select a user or group and then select Remove. 
• Allow or deny a user or group access to the feature by selecting or 

clearing the corresponding check box and then selecting OK. 
• Add a user account or user group by selecting Add. This option 

displays the Select User and Computer dialog box. 

6. (optional) In the Select User or Group dialog box: 

• Select a user, user group, computer, or computer group and then 
select OK. 

• Select Create New to create and then add a new user, user group, 
computer, or computer group. 

7. Select OK to close the View Properties dialog box. 

 
Tip: Restart all FactoryTalk Batch components to update security changes made in the 
FactoryTalk Directory. 
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If you assign specific users and/or groups to a Batch Command or Phase 
Command and enable the corresponding Confirm policy setting, then only 
the specified users are allowed to issue the command. (See the FactoryTalk 
Batch Administrator Guide for more information.) 

The Reactivate Step button on the Instructions view of the eProcedure Client 
is disabled if you do not have permission to reactivate steps. When you access 
the Instructions view, the eProcedure Client checks the FactoryTalk Security 
policy settings for the command. If you have permission to reactivate steps, 
but the CONFIRM value for the ReactivateStep policy setting is True, the Log 
on to Confirm User dialog box prompts for a user ID and password when the 
Reactivate Step button is clicked. If the user is authenticated, the step 
reactivation proceeds. If not, an error message is displayed. (See the 
FactoryTalk Batch Administrator Guide for more information.) 

 

Enable Batch View confirm 
settings 
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Chapter 4 

The FactoryTalk Batch Service Manager 

The FactoryTalk Batch Service Manager is used with the FactoryTalk Batch 
Server, FactoryTalk Batch View Server, and FactoryTalk Event Archiver, when 
FactoryTalk Event Archiver is configured as a Windows service. The Service 
Manager manually starts and stops the FactoryTalk Batch Server and 
manually starts, pauses, continues or stops FactoryTalk Event Archiver 
services. The Service Manager accesses the Batch Server Statistics dialog box, 
which gives access to COM server information, COM client status, error 
information, and other FactoryTalk Batch Server information. 

 
Tip: To command the FactoryTalk Batch Server, FactoryTalk Batch View Server, or FactoryTalk 
Event Archiver services, you must have local administrator privileges on the computer where the 
server and/or FactoryTalk Event Archiver services are installed. If you do not have local 
administrator privileges, you will have view-only privileges. 

 

The FactoryTalk Batch Server, FactoryTalk Batch View Server, and 
FactoryTalk Event Archiver operate as Windows services. During FactoryTalk 
Batch installation, the user account specified during the installation is 
assigned to the Log On As: This Account: option, found in the (Administrative 
Tools) Services dialog box. 

Running as a Windows service allows the FactoryTalk Batch Server to run in 
the absence of an interactive Windows logon. Logging on or logging off 
Windows during operation does not disrupt the server execution. 

Configure the FactoryTalk Batch Server to start automatically, giving server 
control to Windows Services, or control the FactoryTalk Batch Server 
manually using the FactoryTalk Batch Service Manager. The Service Manager 
also controls the type of boot method that the server uses, and runs the server 
in demo mode. 

 
Tip: Specifying the boot method or demo mode in the FactoryTalk Batch Service Manager does not 
alter the Batchsvr.ini file and has no effect on the server when automatically starting. 
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The FactoryTalk Batch Service Manager dialog box is organized into three 
areas:  

• Connection 
• Service state 
• Server 

The Connection area contains: 

Item Definition 

Computer Displays the selected computer. 
Select Computer Selects the computer where the service is located. 
Service Allows you to select a service from a list of batch services for the 

selected computer. 

The Service state area contains two sections.  

• The buttons allow you to select a service state: 
Item Definition 

Stop Stops the selected service. 
Pause Pauses the selected service. This button is not enabled for the batch 

server. 
Start/ 
Continue 

Starts the selected service or continues a service that has been 
paused. 

• The traffic light graphic displays the current service status with an 
accompanying color: 
STARTING None 

RUNNING Green 

STOPPED Red 
PAUSED Yellow 
NOT CONNECTED None 
START PENDING None 

 

 
Tip: The state of the FactoryTalk Batch Service Manager (information from the Connection and 
Server groups) is stored from the last time the Service Manager was run. These values are written 
when the FactoryTalk Batch Server is closed. 

 

The Server area options include: 

Item Definition 

Allow Demo Mode The FactoryTalk Batch Server runs with full functionality without a license 
for a two-hour period. After two hours, the server stops running. 

Allow Grace Period The FactoryTalk Batch Server starts when a valid activation is not found. 
The grace period is seven days, after which a valid FactoryTalk Activation 
license is required. 

Cold Boot The FactoryTalk Batch Server starts in a completely initialized condition. 
All restart data is erased and all recipe content is removed from the Batch 
List. 

FactoryTalk Batch Service 
Manager dialog box 
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Item Definition 

Warm Boot The FactoryTalk Batch Server starts and attempts to restore the set of 
batches that were on the batch list when the server previously 
terminated. The restart files are altered so only one warm restart may be 
attempted. 

Warm All Boot Restarts the FactoryTalk Batch Server only if it is able to restore all of the 
batches to the batch list. Restart does not alter the restart files so another 
warm-all or warm restart may be attempted. This is the default setting for 
automatic restarts. 

Verify/Deploy Area Model Opens the Verify/Deploy Area Model dialog box.  
Server Details Opens the Batch Server Details dialog box. 

 

The Connection area contains: 

Item Definition 

Computer Displays the selected computer. 
Select Computer Selects the computer where the service is located. 
Service Allows you to select a service from a list of batch services for the 

selected computer. 

 

The Service State area contains buttons, text and a graphic traffic light 
service state representation.  

 

The following server states and corresponding colors are displayed: 

STARTING None 

RUNNING Green 

STOPPED Red 
PAUSED Yellow 
NOT CONNECTED None 

Connection 

Service state 
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START PENDING None 

The Service State area contains the following buttons: 

Item Definition 

Stop Stops the selected service. 
Pause Pauses the selected service. This button is not enabled for the batch 

server. 
Start/ 
Continue 

Starts the selected service or continues a service that has been 
paused. 

 

Tip: The state of the FactoryTalk Batch Service Manager (information from the 
Connection and Server groups) is stored from the last time the Service 
Manager was run. These values are written when the FactoryTalk Batch 
Server is closed. 

 

The Server area provides various server options.  

 

The Server area options include: 

Item Definition 

Allow Demo Mode The FactoryTalk Batch Server runs with full functionality without a license 
for a two-hour period. After two hours, the server stops running. 

Allow Grace Period The FactoryTalk Batch Server starts when a valid activation is not found. 
The grace period is seven days, after which a valid FactoryTalk Activation 
license is required. 

Cold Boot The FactoryTalk Batch Server starts in a completely initialized condition. 
All restart data is erased and all recipe content is removed from the Batch 
List. 

Warm Boot The FactoryTalk Batch Server starts and attempts to restore the set of 
batches that were on the batch list when the server previously 
terminated. The restart files are altered so only one warm restart may be 
attempted. 

Server 
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Item Definition 

Warm All Boot Restarts the FactoryTalk Batch Server only if it is able to restore all of the 
batches to the batch list. Restart does not alter the restart files so another 
warm-all or warm restart may be attempted. This is the default setting for 
automatic restarts. 

Verify/Deploy Area Model This button opens the Verify/Deploy Area Model dialog box.  
Server Details This button opens the Batch Server Details dialog box. 

 

The FactoryTalk Batch Server Details dialog box displays an overview of the 
current system’s status and the current running area model. The area model 
file referenced is specified in the Server Options dialog box accessed from 
FactoryTalk Batch Equipment Editor. The FactoryTalk Batch Server Details 
dialog box is organized into five tabs. 

 

The General tab lists data on the number of batches and prompts being 
currently handled by the FactoryTalk Batch Server, as well as the Windows 
time on the server, the time the batch server started, and the name and 
creation date of the current area model. 

The General tab contains the following: 

Field Definition 

Batch Count The number of batches loaded in the FactoryTalk Batch Server. 

Prompts Count The number of prompts currently existing within all batches. 
Version The version number of the FactoryTalk Batch Server. 
Time The time as specified by Windows on the FactoryTalk Batch Server. 
Started at The time the FactoryTalk Batch Server started. 
Area Model File Name The name of the currently active area model. 
Area Model Date The file date of the currently active area model at the time of 

FactoryTalk Batch Server startup or the last update. 

 

The Messages tab is used to monitor FactoryTalk Batch Server log 
information. The messages displayed in the three sections are the most recent 
messages written to the server log by the server. 

The Messages tab consists of the following: 

Field Definition 

Info The most recent Info-type entry in the log file. Info entries are log 
entries recorded as a part of the normal execution. 

FactoryTalk Batch Server 
Details dialog box 

FactoryTalk Batch Server 
Details dialog box - General 
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Field Definition 

Warning The most recent Warning-type entry in the log file. Warning entries 
indicate that a minor irregularity the system detected. The irregularity 
was handled by the system or the system is not sure of the occurrence’s 
implications. 

Severe The most recent Severe-type entry in the log file. Severe entries 
indicate that the system encountered a severe error condition. The 
system handled the situation as best it could. 

The PCD Communications tab is used to monitor the FactoryTalk Batch 
Server communication status and any data servers that are communicating 
with the server. Verification of all tags, phases, and equipment operation 
sequences associated with the current area model is also performed. 

The PCD Communications tab consists of the following components: 

Field Definition 

Data Server Status Lists of all configured data servers in the area model and the 
communication status between FactoryTalk Batch and these data server(s). 

Tag Verify Status Indicates if the verification function is READY, IN PROGRESS, or COMPLETED. 
Tag Verify Verified Indicates the number of tags, phases, and equipment operation sequences 

that the server processed during tag verification. 
Tag Verify Bad Indicates the number of tags, phases, and equipment operation sequences 

that the server was unable to verify. Bad tags, phases, and equipment 
operation sequences indicate either the data server cannot supply the data 
requested by the FactoryTalk Batch Server or the data was not of the 
expected type. 

Tag Verify Total Indicates the total number of tags, phases, and equipment operation 
sequences. 

Start Starts the verification process. 
Stop Stops the verification process. 

 

The View Communications tab is used to monitor the number of Dynamic 
Data Exchange (DDE), Component Object Model (COM) and Ole for Process 
Control (OPC) conversations taking place between the FactoryTalk Batch 
Server and Client software, such as FactoryTalk Batch View and ActiveX 
Controls. 

The View Communications tab consists of the following: 

Item Definition 

DDE Connections The number of DDE connections attached to the FactoryTalk Batch 
Server. 

COM Connections The number of COM connections attached to the server. 
OPC Connections The number of OPC connections attached to the server. 
Items The number of connection items the server currently supports. 

FactoryTalk Batch Server 
Details dialog box - PCD 
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FactoryTalk Batch Server 
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The FactoryTalk Batch Service Manager communicates with the Windows 
Services of the selected computer to determine available services. There may 
be a noticeable delay as communications are established, marked by the 
cursor displayed as an hourglass. If the FactoryTalk Batch Service Manager 
cannot communicate with the selected computer’s Windows Services, a 
message box is displayed stating that the FactoryTalk Batch Service Manager 
failed to connect to the specified computer. 

The FactoryTalk Batch Phase Simulator must be running to test FactoryTalk 
Batch in a demo environment. For more information, see The FactoryTalk 
Batch Phase Simulator in the FactoryTalk Batch Administrator Guide. 

IMPORTANT The FactoryTalk Batch Server cannot start if Security Authority is enabled and there 
is a mismatch between the Security Authority Identifiers (SAIs) in the area model and 
the FactoryTalk Network Directory. For information on your recovery options, see 
Troubleshooting in the FactoryTalk Batch Equipment Editor User Guide. 

To start the FactoryTalk Batch Server service: 
1. Select Start > Rockwell Software > Batch Service Manager. The Batch 

Service Manager opens. 
2. Select Select Computer. The Select Computer dialog box opens. 

IMPORTANT Administrator privileges are required to perform this procedure. 

3. In the Enter the object name to select area, enter the name of the 
computer where the FactoryTalk Batch Server is installed (or select the 
Advanced button to search for a computer). 

4. Select OK to close the Select Computer dialog box. 
5. From the Service list, select FactoryTalk Batch Server. 
6. (optional) Select Allow Demo Mode if you want to run FactoryTalk 

Batch in demo mode. If you run FactoryTalk Batch in the demo mode, 
be aware that the Server stops after two hours of operation. 

7. Select the method to use for restarting the server after a service halt. 

• Cold Boot: Restarts the server in a cold state. All journal data or 
recipe content is erased upon startup. If Security Authority is 
enabled, SAIs in a secured area model and any secured recipes must 
match the current Network FactoryTalk Directory SAI. 

• Warm Boot: Restarts the server, restoring the set of batches that 
were on the batch list when the server previously terminated. No 
validation for Security Authority is performed. 

• Warm All Boot: Restarts the server only if it is able to restore all of 
the batches to the batch list. No validation for Security Authority is 
performed. 

8. Select the Start/Continue button to start the service. Wait for the 
status to change to RUNNING and the light is green. 

Start the FactoryTalk Batch 
Server service 
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9. Select the Server Details button. The FactoryTalk Batch Server Details 
dialog box opens. 

10. Select the PCD Communications tab. The Data Server Status box 
displays the status of the conversation. Make sure that conversation is 
GOOD. 

11. Select Start. The tag verification process begins. When tag verification 
is COMPLETED, select OK, or select Stop to end the verification 
process and then select OK. 

 
Tip: If the number of COM servers exceeds the viewable area within the Data Server Status 
box, a scroll bar displays, enabling you to scroll through the list. 

12. Select Close. The Batch Service Manager dialog box closes. 

 
Tip: If software component conversation becomes LOST while running in Demo mode, make 
sure that the simulator is running and try starting the server(s) again. For more information, 
see Start the FactoryTalk Batch phase simulator. 

 

The FactoryTalk Batch Server is the engine that runs FactoryTalk Batch. It is 
this component that allows integration with the process-connected devices 
(PCDs) and third-party software packages. 

The FactoryTalk Batch Server operates as a Windows Service, which means 
you can configure the Server to start automatically and give control of the 
Server service to the Windows Service Manager. Because the FactoryTalk 
Batch Server runs as a service, logging on or off Windows during operation 
does not disrupt the operation of the Server. 

Using the FactoryTalk Batch Service Manager, you can control the FactoryTalk 
Batch Server manually, select the boot method for the Server, and configure 
the Server to run in Demo mode. Use the FactoryTalk Batch Equipment Editor 
to configure the FactoryTalk Batch Server. 

The FactoryTalk Batch Server coordinates the following functions: 

• Creating a Batch: Transforms the configured recipe into an executable 
working recipe. 

• Executing a Recipe: Communicates with the process-connected 
devices to execute phases. 

• Arbitrating Equipment: Allocates resources based on recipe and 
operator requirements. 

• Collecting Data: Gathers and stores production information for 
reporting and archiving. 

• Performing Client Communications: Transfers data between the 
process-connected devices (PCDs), operator displays, Human Machine 
Interfaces (HMIs), databases, and various other software packages. 

See the FactoryTalk Batch Equipment Editor User Guide and the FactoryTalk Batch 
Administrator Guide for more detailed information about the FactoryTalk Batch 
Server. 

FactoryTalk Batch Server 
overview 
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The installation process placed the SampleDemo1 and SampleDemo2 folders in 
the BATCHCTL share on your hard drive. Within each of these SampleDemo 
folders are four subfolders that contain the files for the area model. To run the 
sample demonstrations, add a FactoryTalk Security user, configure the 
FactoryTalk Batch Server to locate the area model, and then verify the recipes 
in the area model. 

 

The following methods are available for restarting the FactoryTalk Batch 
Server after a service halt: 

Cold Boot Restarts the FactoryTalk Batch Server in a cold state. All journal data or recipe 
content is erased upon startup. If Security Authority is enabled, SAIs in a 
secured area model and any secured recipes must match the current Network 
FactoryTalk Directory SAI. 

Warm Boot Restarts the FactoryTalk Batch Server, restoring the set of batches that were 
on the batch list when the FactoryTalk Batch Server previously terminated. No 
validation for Security Authority is performed. 

Warm All Boot Restarts the FactoryTalk Batch Server only if it is able to restore all of the 
batches to the batch list. No validation for Security Authority is performed. 

 

Use the Allow Grace Period option on the Batch Service Manager dialog box 
to start the FactoryTalk Batch Server in the event that it cannot find a valid 
activation license. The grace period is seven days. 

To enable a grace period: 
1. Select Start > Rockwell Software > Batch Service Manager. The Batch 

Service Manager opens. 
2. Select Select Computer. The Select Computer dialog box opens. 
3. In the Enter the object name to select area, enter the computer name 

where the batch server is installed (or click the Advanced button to 
search for a computer). 

4. Click OK to close the Select Computer dialog box. 
5. From the Service list, select FactoryTalk Batch Server. 
6. Select Allow Grace Period enable grace period activation. 
7. Click the Start/Continue button to start the service. Wait for the status 

to change to RUNNING. 

The FactoryTalk Batch Server searches for valid activations first. If the 
appropriate activation is not found, the server will start under a grace 
period activation. The FactoryTalk Batch Server checks for valid 

Sample demonstration 
setup 

Batch Service Manager 
dialog box - Server options 
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activation licenses every four hours until it either finds one or the 
grace period expires. 

8. Click Close. The Batch Service Manager dialog box closes. 

 

When the FactoryTalk Batch Server starts, it performs a license check. If a 
valid activation is found, a successful license check is returned to the server. 
As a result of the license check, the server determines which applications have 
a license. 

If its normal license check process fails, the server requests grace period 
activation from FactoryTalk Activation. The manner in which the grace period 
activation is requested depends on the area model and why the license check 
process failed. The server will log the request for, and receipt of, the grace 
period license. 

When grace period activation is requested for multiple activations by one 
process, the grace period is ended and the timer reset when any of the 
multiple activations can be successfully obtained. 

Every four hours the FactoryTalk Activation software attempts to check out 
each activation requested as a grace period activation by the FactoryTalk 
Batch Server. If any one of these activations is successfully checked out, the 
grace period for the server ends. 

 
Tip: If the FactoryTalk Batch Server is started in the Demo mode, an exception is made to the 
license and unit checks. Even if no licenses are found, the server will run for two hours and then 
shut down. 

 

Define a custom service to command the FactoryTalk Batch Server and 
FactoryTalk Event Archiver services using the FactoryTalk Batch Service 
Manager. To make a service available to the Service Manager, you must enter 
the file name of the executable for the service in a service registry key. This key 
is located at: 

HKEY_LOCAL_MACHINE\SOFTWARE\BATCHCTL\Services 

Grace periods in 
FactoryTalk Batch Server 

Add a custom service 
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To add a custom service: 
1. In the Registry Editor, select the 

HKEY_LOCAL_MACHINE\SOFTWARE\BATCHCTL\Services 
subkey. 

 
2. From the Edit menu, select New > Key. A new key folder is added. 
3. Enter the Key Name without the file extension. 
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Chapter 5 

The FactoryTalk Batch Server 

The FactoryTalk Batch Server is the FactoryTalk Batch component that 
controls and coordinates system information, phases, and recipes. The 
FactoryTalk Batch Server allows integration with process-connected devices 
and third-party software packages. The FactoryTalk Batch Server must be 
started and remain active during all batch functions. 

 

FactoryTalk Batch Server configuration can be verified and customized as 
needed. Configuration includes specifying the startup method (Automatic or 
Manual), specifying the restart type (Warm, Warm All, or Cold), and setting 
the server options. 

 
Tip: The FactoryTalk Batch Server service is configured to run as a Windows Server 2012 user. 
Changing the user account in which the server runs is done through Services. 

 

Verify the FactoryTalk Batch Server startup and account types using the 
Services Administrative Tool. You must be logged on with local administrative 
privileges to configure the server. 

To specify the startup type: 
1. Select Administrative Tools > Services.  
2. From the list of services, double-click Batch Server.  
3. In the Startup type area, select Automatic to allow the batch server to 

start automatically upon system startup. 
4. Select the Log On tab. 
5. From the Log On As area, select This account. 
6. Select Browse. The Select Users dialog box opens. 
7. Select the User to be used for the batch server, and then select OK.  
8. In the Password box, enter the password for the batch server account. 
9. In the Confirm password box, enter the password. 
10. Select OK to close the Batch Server Properties dialog box. 
11. Close the Services dialog box. 

FactoryTalk Batch Server 
service configuration 

Specify the startup type 
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Configure the FactoryTalk Batch Server and FactoryTalk Event Archiver using 
the Server Options dialog box in FactoryTalk Batch Equipment Editor. The 
configuration information for the server indicates how it communicates with 
FactoryTalk Batch View and the data server(s). Configure FactoryTalk Event 
Archiver to specify if and how electronic batch record files (.evt) are inserted 
into the ODBC-compliant database. 

Changing items such as FactoryTalk Batch Server information, area model, 
and the error logging directory take effect when the server is restarted. 
Changing items such as the recipe directory and batch journal directory take 
effect the next time the server accesses these items. None of the items in 
FactoryTalk Event Archiver configuration require the server to be restarted. 
These changes take effect the next time the server needs that configuration 
item. 

IMPORTANT FactoryTalk Batch does not support the use of mapped drives. Do not use mapped 
drives for project directories. 

 

The default project settings for a computer on which the FactoryTalk Batch 
Server is installed are universal naming convention (UNC) names for all 

FactoryTalk Batch Server 
option configuration 

Server Options dialog box - 
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except the Initialization File Name. If the server is installed on another 
computer, then the Initialization File Name would use UNC names. 

 

Set directories for the following: Primary Journal, Secondary Journal, Error 
Logging, Instructions (if you are using FactoryTalk eProcedure), and 
Equipment Database.  

IMPORTANT The Primary Journal path must be defined or the FactoryTalk Batch Server will not 
start. The Primary Journal path must be on the server computer in the BATCHCTL 
share. In addition, if the Primary Journal or Secondary Journal path is invalid, the 
server will not start. If an invalid path is used, an error message indicating the invalid 
path is written to the batchsvr.log file. 

To set project directories: 
1. In FactoryTalk Batch Equipment Editor, select Options > Server 

Options. 
2. Select the Project Settings tab. 
3. Select Browse to open the Select Directory dialog box. 
4. Select the appropriate directory, and then select OK to return to the 

Server Options dialog box. The selected UNC directory path name is 
inserted into the appropriate box. 

Set project directories 
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Recipes can be stored either as binary files, in a SQL Server Database, or as 
XML files 

To configure recipe storage 
1. Open FactoryTalk Batch Equipment Editor. 
2. On the menu bar, select Options to open the Server Options dialog box 
3. Under Store Recipes Using, select one of these options for storing 

recipes: 

• Binary Files (default format): Stores recipes in separate files 
according to the recipe level and specified directory: 

Stores procedures as .bpc files 
Stores unit procedures as .upc files 
Stores operations as .uop files 

• Microsoft SQL Server Database: Stores recipes in a SQL Server 
database. 

 
Tip: If SQL Server is not installed on the same computer as the Batch 
Client, perform a custom installation of SQL Server and install the Client 
Tools Connectivity option. This displays a list of available SQL Server 
databases in the Server Options dialog box.  

• XML Files: Stores recipes in separate .xml files:  

Stores procedures as .pxml files 
Stores unit procedures as .uxml files  
Stores operations as .oxml files 

4. Select OK to apply the configuration settings. 
 
 

Below the Store Recipes Using area is the Enable Recipe Versioning check 
box. Check this box to enable Recipe Versioning, a system-enforced naming 
convention that stores and protects recipe revisions. By default the box is 
unchecked and recipe versioning is disabled. 

IMPORTANT FactoryTalk Full Edit access to FactoryTalk Batch Equipment Editor is required to 
enable and disable recipe versioning. 

 

The Restart Control tab allows you to specify a restart method to initiate in 
the event of a server computer failure. Selecting Cold Restart will restart the 
FactoryTalk Batch Server in an uninitialized state and all recipe content is 
erased. Selecting Warm Restart (the default) forces the server (or backup 
server) to restart in the same state it was in prior to the failure, without any 

Configure recipe storage 

Recipe versioning 

Server Options dialog box - 
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loss of journal data or recipe content. Selecting Warm All Restart allows the 
server to restart only if it is able to restore all of the batches to the batch list. 
Warm All Restart is the default setting used by the automatic restart function. 

The Restart Control tab also allows you to specify primary and secondary path 
names for the storage of files containing restart information. (See Specify the 
startup type for more information.) 

IMPORTANT You must define a valid Primary Restart path or the FactoryTalk Batch Server will not 
start, and the following error message is logged in the Windows Server event log file: 
Unable to start because RestartDirectoryPath key not specified in Batchsvr.ini.  
In addition, if the Primary Restart or Secondary Restart path is invalid, the server 
will not start. 

 

FactoryTalk Batch can be configured to store batch journals and batch restart 
information in two separate locations. If there is a hardware failure on the 
primary FactoryTalk Batch Server computer, secondary server performs a 
manual failover. The second computer must be capable of running the server. 
Define redundant servers by specifying the primary and secondary restart 
path names. These path names indicate where system files are written to 
should the system experience a failure. If the secondary path name is not 
specified, FactoryTalk Batch does not create secondary files. 

 
Tip: Archiver recovery — The eventdir.txt and the archque.txt are not updated as secondary 
files. As part of the manual failover procedure, manually copy the files from the primary directory 
to the secondary directory. 

Install the area model file and all recipe files and, if using eProcedure, all 
instruction files on both the primary server and the secondary server. 

 

FactoryTalk Batch can be configured to store batch journals and batch restart 
information in two separate locations.  

To define redundant servers: 
1. From the FactoryTalk Batch Equipment Editor Options menu, click 

Server Options. 

Redundant servers 

Define redundant servers 
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2. Select the Restart Control tab. 

 
3. In the Restart Type area, click on a selection, or accept the default, 

Warm Restart. 
4. Click the Primary Path browse button. The Select Directory dialog box 

opens. 
5. Select the MyProject\restart folder located in the BATCHCTL share on 

the primary server’s hard drive (the default is c:\Program Files 
(x86)\Rockwell Software\Batch\MyProject\restart), and then click 
OK. 

6. Click the Secondary Path browse button. The Select Directory dialog 
box opens. 

7. Locate and select the MyProject\restart folder located in the 
BATCHCTL share on the secondary server’s hard drive, and then click 
OK. 

8. Repeat steps 1 through 7 on the redundant server computer, selecting 
the Batch\MyProject\restart folder on the redundant server as the 
Primary Path. The Secondary Path can remain blank or point to 
another redundant server. Additionally, you must configure a data 
server to communicate with the process controller on the redundant 
server computer. The redundant server computer needs to 
communicate with the process controller that is running the phase 
logic. 

 
Tip: You must also verify that the primary and secondary journal project directories are 
defined.  

 
 

 

Use the Batch Reporting tab to select the reporting application for generating 
batch reports and archiving Batch data. Never is the default reporting 
application. 

Server Options dialog box - 
Batch Reporting tab 
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To use the Server Options dialog box - Batch Reporting tab: 
1. Select the Batch Reporting tab. 

 
2. Select the appropriate option from the Reporting Application area. 

The following sections define the available reporting application 
options. 

 

As of version 10.00, the Report Editor functionality is no longer supported or 
available. If you are currently using the Report Editor functionality, it is 
recommended that you transition to the standard reporting that is available 
using the Rockwell Automation Knowledgebase - Answer ID 62366. 

 

Selecting Archiver (End of Batch) defers control of batch reporting to 
FactoryTalk Event Archiver and only performs batch reporting upon removal 
of the batch from the Batch List. The End of Batch runs in the security context 
of the FactoryTalk Batch Server. When using End of Batch archiving, 
FactoryTalk Event Archiver must be disabled as a Windows service and cannot 
be controlled using the FactoryTalk Batch Service Manager. (See the 
FactoryTalk Event Archiver User Guide for information on disabling FactoryTalk 
Event Archiver as a service.) 

 
Tip: If Event Journal Signatures are enabled, specify Archiver (End-of-Batch) archiving to ensure 
that all event journal records are properly archived. 

To perform end of batch archiving: 
1. Select Archiver (End of Batch). 
2. In the Archiver area, select Delete files after archive to allow for the 

deletion of the .evt files after FactoryTalk Event Archiver has stored the 
data in the ODBC database. 

IMPORTANT Deleting files after archiving is not a reversible action and is not 
recommended. 

Report Editor 

Perform end of batch 
archiving 
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3. In Table Name, type the name of the table that contains the Batch data. 
The default is BATCHHIS. 

The Database Connect String box should contain, at a minimum, 
ODBC;. It updates automatically when the data source is selected the 
first time FactoryTalk Event Archiver is started after installation. 
However, if you know the name of the data source, enter 
ODBC;DSN=DataSourceName; and skip the FactoryTalk Event 
Archiver setup function. 
To change the default Table Name from BATCHHIS: 

4. Create a new table. 
5. Update the stored procedure named BHInsert to use the new table 

name. (See the FactoryTalk Event Archiver User Guide for instructions on 
creating a new table.) 

 

Use Archiver (Incremental) to defer control of batch archiving to FactoryTalk 
Event Archiver and to perform batch reporting at user-defined intervals 
during batch execution. Specify the Incremental period between active 
archiving in Minutes or Seconds. The minimum setting is 5 seconds. The 
maximum is 9999 minutes. Setting the value outside of this range causes 
FactoryTalk Event Archiver to run in 5 minute incremental periods. 

To update the incremental period after making changes, stop and restart the 
Incremental Archiver. 

Configure the Incremental Archiver with a Windows user account that has 
administrative privileges to log on to the system. When using incremental 
archiving, configure FactoryTalk Event Archiver to run as a Windows service 
with an automatic startup type. Use the FactoryTalk Batch Service Manager to 
monitor and control FactoryTalk Event Archiver service. (See the FactoryTalk 
Event Archiver User Guide for information on enabling FactoryTalk Event 
Archiver as a service.) 

To perform incremental archiving: 
1. Select Archiver (Incremental). 
2. In the Archiver area, select Delete files after archive to enable the 

deletion of the .evt files after FactoryTalk Event Archiver has stored the 
data in the ODBC database. 

IMPORTANT Deleting files after archiving is not a reversible action and is not 
recommended. 

3. In Table Name, type the name of the table that contains the batch data. 
(The default is BATCHHIS.) 

4. In Incremental Period, type a value and select Minutes or Seconds. 

Perform incremental 
archiving 
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Select User-Defined (End of Batch) to define a batch reporting application 
that is not listed in the Reporting Application area. Specify paths and names 
of the application’s .ini and .exe files. 

To perform user-defined end of batch: 
1. Select User-Defined (End of Batch). 
2. Select the  Executable File browse button to locate the application’s 

executable file. The dialog box opens. 
3. In the Select Archiver Executable File dialog box, select the 

appropriate .exe file, and then select Open. 
4. Select the Initialization File browse button to locate the application’s 

initialization file.  
5. In the Select Archiver Initialization File dialog box, select the 

appropriate .ini file, and then select Open. 

 

Select this option if no batch reporting or archiving application is to be used. 

 

Does not maintain a queue. This is the default selection. 

IMPORTANT The Never setting causes the archiver queue file to not get written to. For a custom 
archiver and when writing to this queue file, use a setting other than Never and 
manually maintain the size of the archive queue file. 

 

The options listed under the Archiver Event Filters tab determine what 
electronic batch record data FactoryTalk Event Archiver inserts into the 
BATCHHIS table. To enable an event filter, select the appropriate check box. 
To disable an event filter, clear the appropriate check box. 

Perform user-defined end 
of batch 
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To enable or disable an event filter: 
1. Select the Archiver Event Filters tab. 

 
2. Select the appropriate check boxes to indicate the event type data for 

the FactoryTalk Event Archiver collection. Clear the check boxes for the 
data that is not to be collected. 

 

The Batch Server tab allows you to select and/or configure FactoryTalk Batch 
Server options (including the hold propagation type), watchdog 
communications timeout settings, FactoryTalk Event Archiver log file size, 
minimum disk space required to add a batch, default batch ID, and whether to 
enable/disable event journal signatures. 

 

  

Batch Server tab 
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The Hold Propagation area allows you to indicate the hold propagation type 
to use when the FactoryTalk Batch Server detects a failure caused by a 
watchdog timeout, a handshake timeout, or a phase failure (PHASE_F > 0). A 
Hold command associated with a failure propagates up through the recipe 
hierarchy as high as the mode and selected option allows. 

Hold Propagation Type Description 

Phase Only the affected phase is held, allowing the balance of the phase’s unit 
and all other units to continue running. 

Operation Only the affected phase and the related operation are held, allowing the 
balance of the operation’s unit and all other units to continue running. 

Unit The phase and the related unit are held and all other units continue 
running. 

Batch (Default) Holds the entire batch when a failure is detected by the 
FactoryTalk Batch Server. 

The following diagram shows how a step’s mode can affect the hold 
propagation. Depending on the step’s mode, the batch may be held at a lower 
level than the selected hold propagation option. 

 

 

The Communications Timeout area allows you to configure the FactoryTalk 
Batch Server’s watchdog timer. 

The Period (msec) box allows you to set the watchdog timer setpoint in 
milliseconds. When the timer expires, the FactoryTalk Batch Server checks 
communication with the process-connected device’s data server and performs 
the set/reset test on the data server watchdog timer. In the event of a failed 
conversation, the server attempts to reconnect. The default is 10000. 

The Allowable Failures box allows you to indicate how many Set/Reset retries 
the FactoryTalk Batch Server should perform before it declares that 
conversation with the server is BAD and issues a HOLD command. The 
default is 5. 

A = Auto Mode
M = Manual Mode
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Tip: The recommended configuration for Batch watchdog and PCD watchdog is that the PLC 
watchdog timer setpoint must be configured to have a value that is 5 % or less of the total value 
of the FactoryTalk Batch Server watchdog timer’s period value and allowable failures value. 
Example: If the server’s watchdog timeout period is set to 10000 milliseconds (10 seconds), and 
the allowable failures is set to 5, then set the PLC watchdog timer setpoint to 47500 milliseconds 
(47.5 seconds): 
 
.95 (5 x 10000) = 47500 

 

IMPORTANT When the watchdog times out in the PCD, the PLI should be designed to set the Phase 
Failure Tag to a nonzero value that represents an understandable message in the 
Phase Failure Enumeration Set such as PCD1 Batch Watchdog Timed Out. 

(See the FactoryTalk Batch Equipment Editor User Guide for details on editing 
enumerations and enumeration sets.) 

 

The Miscellaneous area allows you to define options relating to the 
batchsvr.log and the batchSvr.ini file. 

The Maximum Log File Size box allows you to input the maximum size (in 
bytes) for the log file. When the log file reaches the maximum specified size, 
all new data is appended to the top of the log and old information is 
overwritten. 

The Minimum Disk Space box allows you to input the minimum disk space (in 
bytes) that must be available before a batch can be added to batch list. This 
helps to avoid data loss due to inadequate disk space. 

The Default Batch ID box allows you to specify a default batch ID; this batch 
ID automatically populates the Batch ID box when each batch is created. 

Enable Event Journals Signatures turns event journal signatures on or off. 
The Event Journal Signature function is a tool for detecting any unauthorized 
changes to electronic batch records (.evt files). (See the FactoryTalk Batch 
System Files Reference Guide for more information about Event Journal 
Signatures.) 

 
Tip: Do not edit the batchsvr.log or batchsvr.ini files directly unless you are specifically instructed 
to do so by Rockwell Automation Technical Support. The batchsvr.ini file contains data items that 
determine the configuration of the FactoryTalk Batch Server and how the server operates in 
relation to the other FactoryTalk Batch components. 

 

For purposes of batch identification, you can create custom default batch IDs, 
and allow or prevent editing of batch IDs. You can also automatically generate 
custom batch IDs. In order to implement this option, you must perform steps 

Miscellaneous 

Batch identification 
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in FactoryTalk Batch View and FactoryTalk Batch Equipment Editor, edit 
some Visual Basic code and compile it into a new DLL. If you are using the 
FactoryTalk Batch ActiveX controls, you can use the BatchID editable property 
to enable or disable editing of batch IDs. For more information, see the 
FactoryTalk Batch ActiveX Controls Library Reference. 

 

The Cross Invocation Descriptors and Defaults tab allows you to specify cross 
invocation labels and set default cross invocation strings for different 
resource types. Use FactoryTalk Batch Equipment Editor to define up to five 
cross invocation strings for each resource within the area model. Each time a 
selection changes in FactoryTalk Batch View and ActiveX Controls, the cross 
invocation strings associated with the equipment resource are retrieved from 
the FactoryTalk Batch Server and evaluated. The contents of these strings can 
indicate a shortcut menu item and subitems, the caption(s) for the shortcut 
menu item(s), and the data that is passed to the automation server.  

 

 

Use the Resource Types list to select a resource type for cross invocation 
labels and strings. Select one of the following from the list: Equipment 
Modules, Process Cells, Resources, or Units. 

 

The Descriptors area allows you to enter up to five cross invocation labels for 
each resource type. These labels are used within the resource’s Edit dialog 
box. 

 

Cross Invocation 
Descriptors and Defaults 
tab 

Resource types 

Descriptors 



Chapter 5  The FactoryTalk Batch Server 
 

60   
 

The Default Values area allows you to assign default cross invocation strings 
to each of the cross invocation labels defined above for the selected resource 
type. Any default cross invocation string can be overwritten when a specific 
resource type instance is edited. 

Tip: Changes to the default value are not applied to the currently configured equipment 
in your area model. However, any new equipment you add to your area model uses 
the new default value settings. 

 
 

This feature is used in conjunction with FactoryTalk eProcedure only. 

The Hyperlink Descriptors and Defaults tab specifies the hyperlink labels and 
default values used with different resource types. The labels and default 
values are used in the resource’s Edit dialog box. You can define up to five 
hyperlink labels and default values for each resource within the area model. 
(Refer to the FactoryTalk eProcedure Administrator Guide for additional hyperlink 
information.) 

The Resource Types list allows you to select a resource type for the hyperlink 
labels and URLs you define. Select one of the following from the list: Phases, 
Process Cells, Resources, or Units. 

The Descriptors area allows you to enter up to five hyperlink labels for each 
resource type. These labels are used within the resource’s Edit dialog box. 

The Default Values area allows you to assign default URLs to each hyperlink 
label defined for the selected resource type. Enter the URL address for the 
hyperlink in the box that corresponds to the correct hyperlink label. The label 
in box 1 of the Descriptors area corresponds to the URL address in box 1 of the 
Default Values area. Default URLs can be overwritten when a specific 
resource type instance is edited. 

 
Tip: If a hyperlink value is not defined, either as a default or when the specific resource type 
instance is created, the hyperlink label is not visible in eProcedure. 

 

Use the Resource Types list to select a resource type for hyperlink labels and 
URLs. Select one of the following from the list: Phases, Process Cells, 
Resources, or Units. 

 

In the Descriptors area, enter up to five cross invocation labels for each 
resource type. These labels are used within the resource’s Edit dialog box. 

 

Default values 
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Use the Default Values area to assign default URLs to each hyperlink label 
defined for the selected resource type. Enter the URL address for the 
hyperlink in the box that corresponds to the correct hyperlink label. The label 
in box 1 of the Descriptors area corresponds to the URL address in box 1 of the 
Default Values area. Default URLs can be overwritten when a specific 
resource type instance is edited. 

 
Tip: If a hyperlink value is not defined, either as a default or when the specific resource type 
instance is created, the hyperlink label is not visible in eProcedure. 

 

These features are used in conjunction with FactoryTalk Batch Material 
Manager only. 

• Option When Material Server Communication is lost 
• Hold on Split Feed 

 

Option when Material Server Communication is lost 

When communication with the Material server is lost, these two options are 
available: Failure and Hold or Switch to Manual. 

By default, the FactoryTalk Batch Server is configured to Failure and Hold. In 
this case, batches are placed in the HELD state when communication with the 
Material server is lost. The FactoryTalk Batch Server automatically resumes 
communication with the Material server when it becomes available. 

To run batches even when communication is lost, configure the FactoryTalk 
Batch Server to Switch to Manual. In Manual mode, the server prompts the 
operator for information normally supplied by the Material Server. Restore 
the communication manually when the Material server becomes available. 
(For more information on restoring communication manually, see the 
FactoryTalk Batch Material Manager Administrator Guide.) 

Default values 

Material Policies tab 
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Hold on split feed 

Choose the Yes option to hold batches or the No option to continue to run 
batches in the event of a split feed. 

The Yes option is the default option and the batch is HELD when a split feed 
occurs. 

For the No option, create a loop in the recipe so that the binding process can 
select another container for material additions when a split feed occurs. Add a 
material loop to the recipe with the Create Material Loop button in 
FactoryTalk Batch Recipe Editor. (For information regarding material loops, 
see the FactoryTalk Batch Recipe Editor User Guide.) 

 

You can choose from two options when communication with the Material 
Server is lost: Failure and Hold or Switch to Manual. 

By default, the FactoryTalk Batch Server is configured to Failure and Hold. In 
this case, batches are placed in the HELD state when communication with the 
Material Server is lost. The FactoryTalk Batch Server automatically resumes 
communication with the Material Server when it becomes available. 

If you want to run batches even when communication is lost, configure the 
FactoryTalk Batch Server to Switch to Manual. In Manual mode, the Server 
prompts the operator for information normally supplied by the Material 
Server. You must restore the communication manually when the Material 
Server becomes available. (For more information on restoring communication 
manually, see Restoring Communication in the FactoryTalk Batch Material 
Manager Administrator Guide.) 

 

You can choose the Yes option to hold batches or the No option to continue to 
run batches in the event of a split feed. 

By default, the Yes option is selected and the batch is HELD when a split feed 
occurs. 

If you select the No option, you must create a loop in the recipe so that the 
binding process can select another container for material additions when a 
split feed occurs. You can easily add a material loop to your recipe with the 
Create Material Loop button in the FactoryTalk Batch Recipe Editor. (For 
information regarding material loops, see the FactoryTalk Batch Recipe Editor 
User’s Guide.) 

 

  

Option when Material Server 
comm is lost 

Hold on split feed 
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The .NET registry key contains the FactoryTalk Batch Server computer name 
and is used by remote clients to locate the server computer. During a 
FactoryTalk Batch Client computer installation, the setup program prompts 
you for the server computer name and then places the name into the .NET 
key. In the event that you change the server computer name, or if you are 
switching control to another FactoryTalk Batch Server computer, you need to 
manually modify the .NET registry key on all remote client computers to point 
to the server computer. 

To modify the .NET registry key: 
1. Open the Registry Editor. 
2. Select the HKEY_LOCAL_MACHINE on Local Machine window. 

Navigate to the SOFTWARE\BATCHCTL\Net subkey. 
3. Double-click the Server registry value. 
4. Modify the value data: Server = <MachineName>, where <MachineName> 

is the computer name on which the FactoryTalk Batch Server is 
installed. 

 

The FactoryTalk Batch Server maintains a detailed record of every recipe’s 
state as the recipe is running. If the server computer were to lose power or 
otherwise fail, use the automatic restart control feature to restart the server. 
Upon restarting the server on a failed server node, the following functions are 
placed into the state that existed prior to termination of the server: 

• Control Recipes 
• Semi-Auto Phase Control 
• Arbitration 

 

If the FactoryTalk Batch Server computer experiences a system failure, then 
restarting the computer starts the server. However, if the FactoryTalk Batch 
Server service fails, then you need to restart the service using the FactoryTalk 
Batch Service Manager.  

To restart the FactoryTalk Batch Server:  
1. Open the FactoryTalk Batch View. Batches on the batch list prior to the 

failure are still on the batch list. All batches that had phases in an 
active state now have transitions in the HELD state, and are in 
MANUAL mode with a failure. 

Modify the .NET registry key 

Use automatic restart 
control to restart the 
FactoryTalk Batch Server 

Restart the FactoryTalk 
Batch Server 
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2. Select the batch, and then click the Auto button to place a batch in 
AUTOMATIC mode. 

3. Click the Clear All Failures button to clear the failures. 
4. Select the batch, and then click the Restart Batch button. The 

previously active phases return to a RUNNING state and the batch 
completes. 

 

FactoryTalk Batch can be configured to store batch journals and batch restart 
information in two separate locations. The use of a secondary server allows 
you to perform a manual failover if there is a hardware failure on the primary 
FactoryTalk Batch Server. The second computer must be capable of running 
the server. 

You must install your area model file and all recipe files (and all instruction 
files if using eProcedure) on both the primary server and the secondary server.  

 
Tip: Archiver recovery - As part of the manual failover procedure you must manually copy the 
eventdir.txt and the archque.txt from the primary directory to the secondary directory. 

 

When the FactoryTalk Batch Server fails, complete the following steps.  

 
Tip: If you are using FactoryTalk Batch Material Manager, refer to the procedure for material-
enabled configuration. 

To configure the FactoryTalk Batch Server for manual failover: 
1. Start the process-connected device communication software on the 

secondary server. The secondary server computer needs to 
communicate with the process controller that is running the phase 
logic. 

2. Ensure that the secondary server’s project directories are assigned to 
local directories in the Server Options dialog box located in 
FactoryTalk Batch Equipment Editor. 

3. Use the FactoryTalk Batch Service Manager to start the FactoryTalk 
Batch Server on the secondary server computer, select Warm or Warm 
All as the startup type. The secondary server allows the batches to be 
restarted based upon information written by the primary server. 

4. (optional) If you are also using eProcedure, use the FactoryTalk Batch 
Service Manager to start the eProcedure Server on the secondary server 
computer. 

5. For each computer running FactoryTalk Batch View, enter the 
secondary server’s computer name as the NET registry key value.  

Perform a manual failover 

Configure the FactoryTalk 
Batch Server for manual 
failover 
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6. Stop and restart each FactoryTalk Batch View instance and any other 
software that communicates directly with the FactoryTalk Batch 
Server. This causes the instance to connect with the secondary server. 

 
Tip: The existing batches are placed in the MANUAL mode with transitions in the HELD state. 
Place the batches in AUTOMATIC mode, clear the failures, and then restart the batch. 

 

Upon failure of the primary FactoryTalk Batch Server computer, if this is a 
FactoryTalk Batch Material Manager system, complete the following steps: 

To configure the material-enabled FactoryTalk Batch Server for 
manual failover: 

1. On the Material server computer, start the Network Editor. 
2. Select the network model for the primary FactoryTalk Batch Server. 
3. Right-click BATCHSERVER in the tree and select Remove Server. 
4. From the File menu, click Synchronize. 
5. Select the network model for the Material server. 
6. Right-click any <Undefined> FactoryTalk Batch Server in the tree, and 

then click Add Server. 
7. Type a name in the Alias box. 
8. Click the Computer Name box, and then select the computer to be used 

as the secondary server. 
9. From the File menu, click Synchronize. 
10. Start the process-connected device communication software on the 

secondary server. The secondary server computer needs to 
communicate with the process controller running the phase logic. 

11. Ensure that the project directories for the secondary server are 
assigned to local directories. Use the Server Options dialog box in 
FactoryTalk Batch Equipment Editor. 

12. Use the FactoryTalk Batch Service Manager to start the FactoryTalk 
Batch Server software on the secondary server computer. Select Warm 
or Warm All as the startup type. The secondary server allows the 
batches to be restarted based upon information written by the primary 
server. 

13. If you are also using eProcedure, use the FactoryTalk Batch Service 
Manager to start the eProcedure Server on the secondary server 
computer. 

14. For each computer running the FactoryTalk Batch View, enter the 
computer name of the secondary server as the NET registry key value.  

15. Stop and restart each FactoryTalk Batch View instance and any other 
software that communicates directly with the FactoryTalk Batch 
Server. This causes the FactoryTalk Batch View instance to connect 
with the secondary server. 

Configure the material-
enabled FactoryTalk Batch 
Server for manual failover 
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Tip: The existing batches are placed in the MANUAL mode with transitions in the HELD state. 
Place the batches in AUTOMATIC mode, clear the failures, and then restart the batch. 

 

The FactoryTalk Batch Server uses a command handshake protocol ensuring 
that commands issued to phases are handled in a serial manner and are not 
lost or overwritten. The protocol has a configurable timeout period. When a 
command handshake timeout condition occurs, an error is generated in the 
phase object that represents the phase, and the batch is placed on HOLD 
based upon the configured hold propagation settings. This allows the operator 
to disconnect the server from the affected phase should the timeout period 
expire. Without this feature, the server must be shut down and restarted if the 
phase stops responding.  

When a command handshake timeout period occurs, the step representing 
the troubled phase in the SFC display turns red and a failure is generated for 
the phase. The message PHASE NOT RESPONDING is shown on the status 
bar when the step is selected. It is also displayed in the Phase List Display area 
of the Phase Control window when the phase is selected. 

A System Message event type is logged into the electronic batch record. The 
description includes the fact that a time-out occurred as well as the type and 
ID of the command that timed out. In addition, the event is recorded in the 
FactoryTalk Batch Server log file with a severity status of SEVERE and the 
description is the type and ID of the timed-out command. 

If a communication error is detected while the command handshake is in 
process, the command handshake timer is stopped. The timer is reset and 
restarted if communication is successfully restored. If the command 
handshake completes after the timeout period, then the commands that are 
pending the handshake completion are processed. However, the error must be 
cleared before the batch can be restarted. 

In order to restart a batch, you must issue the CLEAR_FAILURES command. 
If the command handshake completes successfully, the error is cleared and 
the batch can be restarted. Otherwise, the error is not cleared and the batch is 
not restarted. The operator should check the execution status of the process-
connected device. 

The Batchsvr.ini file contains an item used to configure the length of time, in 
seconds, that the FactoryTalk Batch Server waits for a command handshake 
before issuing a timeout. If the item is not included in the Batchsvr.ini file, it 
defaults to 60. The valid range is 5 to 600. 

[XMAN] CommandTimeOut=90 

This value is read when the FactoryTalk Batch Server starts. If you change the 
value, stop and restart the server. 

Command handshake 
timeout 
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Chapter 6 

Windows event log 

The Windows Event Log service records application, system, and security 
information. This information can be viewed using the Event Viewer.  

 
Tip: Supported Windows versions for FactoryTalk Batch are listed in the FactoryTalk Batch 
Components Upgrade and Installation Guide. 

 

From the Windows Event Viewer, you can double-click any log entry to 
display its properties. 

 

There are 10 items for a Windows event log entry. Six of these are identical for 
all FactoryTalk Batch Server events. These items, along with a description, are 
listed below. The Category, Event ID, and Description are described in the 
table following the list. 

View event log entry 
properties 



Chapter 6  Windows event log 
 

68   
 

Item Description 

Date Date that the event occurred. 
Time Time that the event occurred. 
Type Type of the event (i.e., Information, Error, etc.). 
User Configured domain user. 
Computer Computer on which the FactoryTalk Batch Server is running. 
Source BatchSvr 
Category Category of the event. 
Event ID ID of the event. 
Description Description of the event. 
Data File and line number within the FactoryTalk Batch Server source code that generated 

the entry. 

 

Category Event 
ID 

Description 

Start 1000 Server demand started successfully in demo mode. 
Start 1001 Server demand started successfully in production mode. 
Start 1002 Server auto started successfully. 
Start 1003 Server failed to auto start. See the Batchsvr.log file for more information. 

Start 1004 Server failed to demand start. See the Batchsvr.log file for more 
information. 

Important: Do not edit the Batchsvr.log files. The Batchsvr.log contains critical information Technical 
Support needs to determine the cause of a FactoryTalk Batch Server failure. 
Start 1005 Command line arguments are inconsistent. 

Start 1006 Unexpected command line argument [Descriptive String]. 
Start 1007 Service handler not installed. 
Start 1008 Not running as a service or StartServiceCtrlDispatcher failed. 
Start 1009 Log directory does not exist. Validate ErrorLogDirectory key value in 

Batchsvr.ini. 
Important: Do not edit the Batchsvr.ini file unless specifically instructed by Technical Support. 

Start 1010 Unable to start due to access permissions on log directory specified by 
ErrorLogDirectory key value in Batchsvr.ini. 

Start 1011 Batchsvr.log file could not be created/opened. Validate pathname in 
Batchsvr.ini. 

Start 1012 Unable to start. Log file (Batchsvr.log or Verify.log) does not have write 
access permission. 

Start 1013 Unable to start. Unable to access log file (Batchsvr.log or Verify.log). 
Start 1014 Unable to start. Verify.log file does not have write access permission. 
Start 1015 Unable to start due to missing Batchsvr.ini file. 
Start 1016 Unable to start due to access permissions on Batchsvr.ini file. 
Start 1017 Unable to start due to access problem with Batchsvr.ini file. 
Start 1018 Access error on Batchsvr.ini detected prior to logging on as user  

specified in Batchsvr.ini. 
Start 1019 Access error on Batchsvr.ini detected while running as user specified in 

Batchsvr.ini. 
Start 1020 Access error on log file detected while running as user specified in 

Batchsvr.ini. 
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Category Event 
ID 

Description 

Start 1021 Access error on event files detected while running as user specified in 
Batchsvr.ini. 

Start 1022 Unable to start because primary event file directory specified by  
EventDirectoryPath key in Batchsvr.ini is missing. 

Start 1023 Unable to start because secondary event file directory specified by 
EventDirectoryPathSecondary key in Batchsvr.ini is missing. 

Start 1024 Unable to start because of access permissions on primary event file 
directory specified by EventDirectoryPath key in Batchsvr.ini. 

Start 1025 Unable to start because of access permissions on secondary event file 
directory specified by EventDirectoryPathSecondary key in Batchsvr.ini. 

Start 1026 Unable to start because of access permissions on Archque.txt file in 
primary event file directory. 

Start 1027 Unable to start because of access permissions on Archque.txt file in 
secondary event file directory. 

Start 1028 Unable to start because of access permissions on Eventdir.txt file in 
primary event file directory. 

Start 1029 Unable to start because of access permissions on Eventdir.txt file in 
secondary event file directory. 

Start 1030 Unable to start because RestartDirectoryPath key not specified in 
Batchsvr.ini. 

Start 1031 Unable to start because RestartDirectoryPath specified in Batchsvr.ini 
missing. 

Start 1032 Unable to start because of access permissions on RestartDirectoryPath 
specified in Batchsvr.ini. 

Start 1033 Unable to start because of access permissions (security?) on  
RestartDirectoryPath specified in Batchsvr.ini. 

Start 1034 Unable to start because RestartDirectoryPath2 specified in Batchsvr.ini 
missing. 

Start 1035 Unable to start because of access permissions on RestartDirectoryPath2 
specified in Batchsvr.ini. 

Start 1036 Unable to start because of access permissions (security) on 
RestartDirectoryPath2 specified in Batchsvr.ini. 

Start 1037 Server started by an ActiveX client. 
Start 1038 Domain user name is blank and must be initialized in the SECURITY section 

of the Batchsvr.ini. The Server will not have any network  
credentials, which means it cannot access anything off node (i.e., data 
servers, event journal files, or recipes). 

Start 1039 Internal Error. Call to CoInitializeSecurity failed. 
Start 1040 Internal Error. Call to RegisterClassObjects failed. 
Start 1041 The SQL Server database cannot be opened. 
Boot 2000 Server warm booting. 
Boot 2001 Server cold booting. 
Boot 2002 Server started. 
Boot 2003 Server warm all booting. 
Boot 3000 Data Server: [Descriptive String] status changed to GOOD. 
Boot 3001 Data Server: [Descriptive String] status changed to SUSPECT. 
Boot 3002 Data Server: [Descriptive String] status changed to LOST. 
Boot 3003 Data Server: [Descriptive String] status changed to BAD. 
Boot 3004 Data Server: [Descriptive String] status changed to an unknown  

conversation status. 
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Category Event 
ID 

Description 

Boot 3005 Data Server: [Descriptive String]. 
Shutdown 4000 Server shutting down. 
Shutdown 4001 Server exception occurred. See the Batchsvr.log file for information. 

Shutdown 4002 Server automatically shutting down from demo mode. 
Tag_Verification 5000 Server tag verification process Started. 
Tag_Verification 5001 Server tag verification process Aborted. 
Tag_Verification 5002 Server tag verification completed, [Descriptive String1] of [Descriptive 

String2] tags verified successfully. 
Registration 6000 Server registered. 
Registration 6001 Server unregistered. 
Registration 6002 Server registered as a service. 
Control 7000 Notify SCM: The service is stopping. 
Control 7001 Notify SCM: Service stopped. 
Control 7002 Notify SCM: The service is starting. 
Control 7003 Notify SCM: The service is running. 
Control 7004 SERVICE_CONTROL_STOP received from Service Control Manager. 

Control 7005 Unexpected SERVICE_CONTROL_PAUSE received from Service Control 
Manager. 

Control 7006 Unexpected SERVICE_CONTROL_CONTINUE received from  
Service Control Manager. 

Control 7007 SERVICE_CONTROL_INTERROGATE received from Service  
Control Manager. 

Control 7008 SERVICE_CONTROL_SHUTDOWN received from Service Control Manager. 

Control 7009 Bad Service Request. 
Category_Debug 8000 Command Line: [Descriptive String]. 
Category_Debug 8001 Argument received from SCM or BatchSCM: [Descriptive String]. 
Category_Debug 8002 HRESULT = [Descriptive String]. 
Category_Debug 8003 Thread [Descriptive String] started. 
Category_Debug 8004 Exception in object [Descriptive String1] in method [Descriptive String2]. 

Category_Debug 8005 Service could not be marked for deletion by the SCM. 
Category_Debug 8006 Debug: [Descriptive String]. 

 

To prevent the system event logs from exceeding the maximum allowable 
size, configure the application and system log to overwrite events as needed. 

To modify event log settings: 
1. Navigate to Control Panel > Administrative Tools > Event Viewer. 
2. Right-click Application, and then select Properties. The Application 

Properties dialog box opens. 
3. In the Log size area, select Overwrite events as needed, and then click 

OK. 

Modify event log settings 
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4. Repeat steps 2 and 3 for the System. 
5. Exit the Event Viewer. 
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Chapter 7 

Cross invocation 

Cross Invocation is the means by which the FactoryTalk Batch View and 
ActiveX Controls pass data to, and activate, an automation server such as an 
HMI or Visual Basic program. The data passed is specific to an equipment 
resource selected from the FactoryTalk Batch Client applications. 

FactoryTalk Batch provides a procedure-centric view of the batches running 
in the plant. The HMI provides an equipment-centric view of these batches. If 
the HMI is an automation server that supports the Cross Invocation interface, 
cross invocation can send equipment-specific information about a batch to 
your HMI. The HMI can then act based on the data received. For example, it 
may invoke a graphic specific to the selected equipment resource or 
information specific to an Equipment Module’s running logic. 

 

Cross invocation is accomplished by way of user-defined and selectable cross 
invocation menu items. If configured for a selected equipment resource, the 
cross invocation menu items are visible and selectable from: 

• FactoryTalk Batch View when the Goto HMI button is selected. 
• The ActiveX Controls when the ActiveX control shortcut menus are 

invoked by right-clicking on the running object. 

If a recipe step is not bound to an equipment resource: 

• The FactoryTalk Batch ProcedureView ActiveX control does not 
display the Cross Invocation menu when you right-click on the step. 

• FactoryTalk Batch View displays a message indicating the step is not 
bound when you select the Goto HMI button. 

Within the FactoryTalk Batch Client applications, there are a number of 
selectable procedural elements. Each of these procedural elements relates to a 
specific equipment resource. Each equipment resource may be configured to 
have cross invocation strings (defined on the Cross Invocation tab of any 
configurable equipment resource in the area model).  

Procedural Element > Equipment Resource > Cross Invocation Strings 

Each cross invocation string defines the following: 

• The text for displaying the Cross invocation menu item. 
• The data for passing to the automation server. 

Cross invocation overview 
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The following table shows the various FactoryTalk Batch View windows and 
the equipment resource to which a selected procedural element is linked. For 
cross invocation to be implemented, the cross invocation strings must be 
configured for the equipment resource. 

FactoryTalk Batch View 
window 

Selectable elements Corresponding equipment resource 

Batch List Batch Process Cell (Procedure) 
Unit (Unit Proc or Operation) 

Procedure as SFC/Table Batch Process Cell (Procedure) 
Unit (Unit Proc or Operation) 

Unit Procedure Unit 
Operation Unit 
Recipe Phase Phase 

Event Journal Batch Process Cell (Procedure) 
Unit (Unit Proc or Operation) 

Unacknowledged Prompts Unacknowledged Prompts Phase 
Phase Control Process Cell Process Cell 

Unit Unit 
Phase Phase 

Arbitration Recipe Process Cell (Procedure) 
Unit (Unit Proc or Operation) 

Process Cell Process Cell 
Unit Unit 
Phase Phase 
Resource Resource 

Alarm Summary N/A N/A 
Phase Summary Phase Phase 

 

Use FactoryTalk Batch Equipment Editor to define up to five cross invocation 
strings for each resource defined within the area model. Each time a 
procedural element is selected in FactoryTalk Batch View or from the ActiveX 
Controls, the cross invocation strings associated with the equipment resource 
corresponding to the selected element are retrieved from the FactoryTalk 
Batch Server and evaluated. The contents of these strings become the 
caption(s) for the cross invocation menu item(s) and optional sub-menu items 
as well as the context data that is passed to the automation server. The context 
data is encapsulated in escape sequences. 

Cross invocation strings are defined according to the following syntax: 

• A cross invocation string must be enclosed entirely in square brackets [ 
]. Anything outside of the square brackets is ignored by the Server. 

• Within the square brackets, the initial text (to the first semicolon) 
indicates the menu item(s) caption(s). 

Cross invocation string 
configuration 
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• All text within the square brackets after the first semicolon defines the 
context data passed to the automation server when the menu item is 
selected. 

• A single string can specify one cross invocation item with any number 
of subitems. The first comma-delimited portion of the cross invocation 
string identifies the menu item for the shortcut menu, and each 
subsequent sub-string identifies a subitem. 

• The data passed in response to all subitems is identical. Subitems are 
optional. 

Example: 
[Menu Item, Subitem 1, Subitem 2; %P, %S, %R] 

The cross invocation string portion that specifies the data to pass to the 
automation server when selecting a menu item is defined by escape 
sequences. The escape sequences are replaced by the context data they 
represent before the string is passed. The valid escape sequences are 
identified in the following table along with their meaning. 

Escape sequence Replace by 

%P The path to the selected step. In some instances, this value can be empty. (See Context 
Data Responses for more information.) 
Examples: 
CreateID 
CreateID \t Procedure \t Unit Procedure \t Operation \t Phase 

%N Equipment resource name to which the selected control recipe corresponds. 
%C Class name from which the equipment resource corresponding to the step was created. 
%T Equipment resource type to which the selected control recipe corresponds. 
%S Computer on which the FactoryTalk Batch Server is executing. 
%B Batch ID of the selected control recipe. 
%M Menu item caption that was selected. If submenu items exist, they appear in the following 

order: the caption of the menu item appended with a colon, then the index number of the 
submenu item appended with a colon, and then the caption of the submenu item selected. 

%R Resource ID of the equipment resource to which the selected control recipe corresponds. 

 

The escape sequences used in the cross invocation strings correspond to the 
current selection in FactoryTalk Batch View or ActiveX Controls applications. 
The context data passed to the automation server is relative to the current 
selection. (See the FactoryTalk Batch View User Guide for information regarding 
selectable elements.) 

The following describes each escape sequence relative to the type of 
procedural element selected: 

Escape 
Sequence 

Procedure Unit Procedure Operation Phase 

%P Path Path Path Path 

Cross invocation string 
escape sequences 
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%N Corresponding 
Process Cell Name  

Corresponding Unit 
name 

Corresponding Unit 
name 

Corresponding 
Phase name 

%C Corresponding 
Process Cell class 
name 

Corresponding Unit 
Class name 

Corresponding Unit 
Class name 

Corresponding 
Phase Class name 

%T 1 (Process Cell) 2 (Unit) 2 (Unit) 3 (Phase) 

%S Node Node Node Node 
%B Batch ID Batch ID Batch ID Batch ID 
%M Menu caption Menu caption Menu caption Menu caption 
%R Corresponding 

Process Cell 
resource ID 

Corresponding Unit 
resource ID 

Corresponding Unit 
resource ID 

Corresponding 
Phase resource ID 

If the control recipe runs across multiple process cells, the context data replaced by %N and %C is the first 
process cell in the process cells list of associated with the recipe. 

The following describes each escape sequence relative to the element selected 
within the FactoryTalk Batch View Phase Control window. (See the FactoryTalk 
Batch View User Guide for information regarding selectable elements.) 

Escape 
Sequence 

Process Cell Unit Phases 

%P Empty Path (if exists). 
The context data that 
replaces %P (when selecting 
a unit) is the unit procedure 
path or operation that owns 
that unit, and blank 
otherwise. 

Create ID (if exists). 
The context data that replaces 
%P when selecting an 
equipment phase is the 
Create ID of the batch within 
which the phase is executing. 
This only exists if that 
equipment phase is currently 
executing within the context of 
a batch. 

%N Name of process cell Name of unit Name of phase 
%C Process Cell Class name Unit Class name Phase Class name 

%T 1 (process cell) 2 (unit) 3 (phase) 
%S Node Node Node 
%B Empty Batch ID (if exists) Batch ID (if exists) 
%M Menu caption Menu caption Menu caption 
%R Process cell resource ID Unit resource ID Phase resource ID 

 

This is an example of a cross invocation string configured in FactoryTalk 
Batch Equipment Editor and the resulting cross invocation menu as seen 
from FactoryTalk Batch View.  

Cross invocation string 
example 
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[DETAIL DISPLAY, VIEW MODE, EDIT MODE; %P, %N, %T, %C, %S, %B, %R, 
%M] 

 

This illustrates the type of data that could be passed to the automation server 
when the Batch ID is selected in FactoryTalk Batch View and the batch is 
running. 

 

 
Tip: The automation server must be configured for responding appropriately to the data. 

 

Once the cross invocation strings are defined, FactoryTalk Batch View and 
ActiveX Controls must be configured to support cross invocation. 

FactoryTalk Batch View is configured to support cross invocation under the 
General tab of the System Configuration and Defaults window. On this tab, 
cross invocation must be selected and the program identifier of the 
automation server must be specified. 

 

Once configured in FactoryTalk Batch View, the cross invocation menu items 
become visible when a procedural element is selected (that corresponds to an 
Equipment Resource with configured cross invocation strings) followed by 
selecting the Goto HMI button. 

The ActiveX Controls are configured to support cross invocation when the 
following two properties are configured for the ActiveX object: 

• InvocationProgID 

FactoryTalk Batch View and 
ActiveX Controls 
configuration for cross 
invocation 
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• ShowCustomMenu 

 
The InvocationProgID property must contain the program identifier of the 
automation server. The ShowCustomMenu property must be set to True so 
that the cross invocation strings are visible on the ActiveX object’s shortcut 
menu during runtime as shown: 
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Chapter 8 

The FactoryTalk Batch Phase Simulator 

FactoryTalk Batch comes with a phase logic simulation program that allows 
you to run the FactoryTalk Batch software and simulate your batch process 
without being connected to a PCD. The FactoryTalk Batch Phase Simulator 
imitates the functionality of a data server and communicates with the 
FactoryTalk Batch Server using the OPC communication protocol. This is a 
powerful tool for testing, experimentation and demonstration purposes.  

 
Tip: The Simulator is automatically started by the FactoryTalk Batch Server if required by the area 
model. 

The Simulator allows you to save report parameter values. 

 
Tip: When running a material-enabled phase, RUNNING logic should not have any configured 
requests. You must set the FEED_COMPLETE report parameter to 1 and set a value for the 
ACTUAL_AMOUNT report parameter. Save the simulation file after making these changes. 

 

Start the FactoryTalk Batch Phase Simulator for the FactoryTalk Batch Server 
and FactoryTalk Batch View to run in a simulated environment. 

To start the FactoryTalk Batch Phase Simulator: 
• Select Start > Rockwell Software > Simulator. The Phase Simulator 

opens. 

 
  

Start the FactoryTalk Batch 
Phase Simulator 
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Upon startup, the FactoryTalk Batch Phase Simulator reads the area model 
that is specified in the Batchsvr.ini file. The area model file name is displayed 
on the title bar. By default, when you first install the software it is set up to 
read ice_cream1.cfg, one of the sample area models shipped with FactoryTalk 
Batch. This file contains the equipment required to run the Sampledemo1 
recipe. The Simulator simulates the RUNNING, STOPPING, HOLDING, 
ABORTING, and RESTARTING states for all phases configured in the recipe. 

 

 
Tip: The Simulator simulates only phase states for area models that have no more than 50 
parameters and 50 report parameters. 

The Simulator menu bar consists of the following options: 

Option Definition 
File Open a simulator (.sim) file, save a file, or exit the Simulator. 
Edit Edit phase configuration, phase status, or unit tag status. 
Protocols Enable or disable the Watchdog and Command Handshake functions. 
Help Open the Simulator About box. 

 

The FactoryTalk Batch Phase Simulator allows you to edit a phase’s 
configuration. You can set the following items for each sequencing state of a 
phase: 

• Dwell Time 
Indicates the length of time, in seconds, that a specific state is active 
for the selected phase. 

• Time of Request 
Indicates the time, within the dwell period, at which a request is made. 

• Type of Request 
Indicates the type of request to make. (Refer to the FactoryTalk Batch 
PCD Programmer Technical Reference Guide for more information 
about requests.) 

• Request Parameters 
Each request can have up to three parameters that further describe the 
request. 

FactoryTalk Batch Phase 
Simulator interface 

Phase Configuration dialog 
box 
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• Continuous Phase Indication 
A continuous phase is a phase whose phase logic does not transition to 
the COMPLETE state. You can simulate continuous phase logic by 
selecting Continuous Phase. When a transition that follows a step 
running continuous phase logic evaluates to TRUE, and the step is not 
involved in Transfer of Control, then the FactoryTalk Batch Server 
sends a STOP command to the phase. If the phase with continuous 
phase logic is involved in Transfer of Control, and the transition 
evaluates to TRUE, the Transfer of Control procedure is executed, 
transferring ownership of the phase from the step prior to the 
transition to the step following the transition. A NEW_PARAMETERS 
command is issued to the phase’s phase logic when the Transfer of 
Control occurs, notifying the phase logic that new recipe parameter 
values associated with the new recipe step are available for download if 
the phase logic requests a download.  

 
Tip: To use a continuous phase in an actual batch, write appropriate phase logic to define 
non-terminating behavior.  
Refer to the NEW_PARAMETERS Command section in the FactoryTalk Batch PCD 
Programmer Technical Reference Guide for more information. 

 

Change the length of time that a specific state is active for the selected phase. 

To change the dwell time: 
1. Start the FactoryTalk Batch Phase Simulator. 
2. Select Edit > Phase Configuration. The Phase Configuration dialog 

box opens. 
3. From the Select Phase list, select the appropriate phase. 
4. From the Select State list, select the state to change the dwell time. 
5. In Dwell Time, type the desired dwell time for the selected state. 
6. Select Update Phase. 

 

Change the time, type, and parameters of the request in a phase. 

To change the sequence of requests: 
1. Start the FactoryTalk Batch Phase Simulator. 
2. Select Edit > Phase Configuration. 
3. In the Phase Configuration dialog box, from the Select Phase list, 

select the appropriate phase. 

Change the dwell time 

Change the sequence of 
requests 
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4. Type an appropriate value in @Time (time is in seconds). This value 
determines when the request is processed. This value must not be 
greater than the Dwell Time.  

For example, if the Dwell Time is 30 seconds, and the @Time value is 
20 seconds, then this request will be processed after the selected state 
has been active for 20 seconds. 

5. Type an appropriate request number in _RQ. (Refer to the FactoryTalk 
Batch PCD Programmer Technical Reference Guide for information on 
request numbers.) 

6. Type any required request parameter data in Q01, Q02, and Q03. These 
parameters are used to further define the request. 

7. Select the Update Phase button. 
8. Select Close. 

 

Simulate continuous phase logic by selecting Continuous Phase. 

To indicate a continuous phase: 
1. Start the FactoryTalk Batch Phase Simulator. 
2. Select Edit > Phase Configuration. The Phase Configuration dialog 

box opens. 
3. From the Select Phase list, select the appropriate phase. 
4. If this is a continuous phase, select Continuous Phase. 
5. Select Update Phase. 
6. Select Close. 

 

The status of a phase can be changed during run time to test phase logic prior 
to implementation. 

• View parameter tag values and associated parameter names 
• View request tag values 
• Set owner of phase to External 
• Change the phase’s state for phases under External Control 
• Restore active requests for HELD/RESTARTED phases 
• Change report parameter tag values 
• Change value of the Failure bit 
• Set phase to COMPLETE 
• Acknowledge/Clear requests of phases under External control 

Indicate a continuous phase 

Phase Status dialog box 
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The phase parameter tag values are read-only and cannot be modified in the 
Simulator. The FactoryTalk Batch Server writes these tags when a download 
request is processed. 

To view phase parameter tag values: 
1. Start the FactoryTalk Batch Phase Simulator. 
2. Select Edit > Phase Status.  
3. Select the appropriate phase from the Select Phase list. 
4. In the Arrays list, select Phase Parameter Tags. Each parameter tag 

associated with this phase is displayed, along with its current value 
and type. 

 

The report parameter tag values can be modified and uploaded to the 
FactoryTalk Batch Server. The uploaded value(s) are reflected in the electronic 
batch record (.evt files). 

To view and update report parameter tag values: 
1. Start the FactoryTalk Batch Phase Simulator. 
2. Select Edit > Phase Status.  
3. In the Select Phase list, select the appropriate phase. 
4. In the Arrays list, select Report Parameter Tags. Each report 

parameter tag associated with this phase displays, along with its 
current value and type. 

5. Enter a new value for the appropriate Report Parameter Tag. 
6. Select Update Report Data to update the tag value. The report tag 

values are uploaded to the Batch Server when an upload request is 
processed. 

 

The FactoryTalk Batch Phase Simulator allows you to change the state of a 
phase. An active phase can be commanded to COMPLETE without gaining 
phase ownership. All other state change commands require the phase be 
under external control. The Start/Stop, Abort/Reset and Hold/Restart 
buttons are modal, in that the command issued is determined based on the 
phase’s active state at the time the button is clicked. Only legal state change 
commands are executed. For example, if a phase is RUNNING and the 
Start/Stop button is clicked, the STOP command is issued. START is not a 
legal command to a phase in the RUNNING state. (Refer to the FactoryTalk 

View phase parameter tag 
values 

View and update report 
parameter tag values 

Phase commands 
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Batch PCD Programmer Technical Reference Guide for additional information on 
legal state transitions.) 

The following table shows the phase’s transition when the state change 
command is received, along with the associated state value (##). 

COMMAND INITIAL STATE FINAL STATE 
COMPLETE  COMPLETE (70) 
START  RUNNING (50) 
STOP STOPPING (30) STOPPED (80) 
ABORT ABORTING (10) ABORTED (90) 
RESET  IDLE (100) 
HOLD HOLDING (20) HELD (60) 
RESTART RESTARTING (40) RUNNING (50) 

 

The FactoryTalk Batch Phase Simulator allows you to change the state of a 
phase.  

To command a phase: 
1. Start the FactoryTalk Batch Phase Simulator. 
2. In the Edit menu, click Phase Status.  
3. In the Select Phase list, select the phase to command. 
4. To set the phase to COMPLETE, click the Set Complete button. 
5. For all other state change commands, set the Owner of the phase to 

External. 
6. Click the appropriate state change command button (Start/Stop, 

Abort/Reset, or Hold/Restart).  

If the requested state change is legal, the server sends the command to 
FactoryTalk Batch View and the phase transitions to the appropriate 
state. The new state value is displayed in the Status register in the 
Phase Status dialog box. 

• If the phase is running and the Abort/Reset button is selected, the 
phase goes to ABORTING. To transition the phase to the ABORTED 
state, select the Set Complete button. 

• If a phase is running and the Hold/Restart button is selected, the 
phase goes to HOLDING. To transition the phase to the HELD state, 
select the Set Complete button. 

  

Command a phase 
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The Owner button acts as a toggle, switching the value in the Owner register 
between zero and one. A zero represents Batch as the owner and a one 
represents an external owner. 

To change ownership of a phase: 
1. Start the FactoryTalk Batch Phase Simulator. 
2. Select Edit > Phase Status.  
3. From the Select Phase list, select the appropriate phase. 
4. To set ownership to External, select Owner when the value in the 

Owner register is 0. 

To set ownership to Batch, select Owner when the value in the Owner 
register is 1. 

 

Requests must be acknowledged and then cleared to allow a phase to continue 
processing when running under External control. The Ack/Clear Request 
button must be clicked twice, first to acknowledge the request, then to clear 
the request. 

To acknowledge and clear a request: 
1. Start the FactoryTalk Batch Phase Simulator. 
2. Select Edit > Phase Status.  
3. In the Select Phase list, select the phase to be commanded. 
4. If the Request register contains a request, select Ack/Clear Request to 

acknowledge the request. The value in the Request register changes to 
10, indicating that the request confirmation was received from the 
Batch Server. 

5. Select Ack/Clear Request to clear the request. Upon clearing the 
request, the value in the Request register changes to 0, indicating that 
the request was cleared. The phase continues to process. 

 

Requests generated by a phase can be stored in the request buffer registers 
should the phase receive a Hold command. The requests can then be copied 
back to the request registers when the phase receives a Restart command. The 
Restore Req and Clear Req registers must both contain a 1 (one) to allow for 
the saving and restoring of requests for a HELD/RESTARTED phase. 

Change ownership of a 
phase 

Acknowledge and clear a 
request 

Restore and clear requests 
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To restore and clear requests: 
1. Start the FactoryTalk Batch Phase Simulator. 
2. Select Edit > Phase Status.  
3. In the Select Phase list, select the phase to be commanded. 
4. In the Restore Req register, type a 1. 
5. In the Clear Req register, type a 1. 

 

The request data tag values are read-only. These may be set by the FactoryTalk 
Batch Phase Simulator when making a configured request or may be written 
to the FactoryTalk Batch Server when processing a phase logic Receive 
Message request. 

To view request data tag values: 
1. Start the FactoryTalk Batch Phase Simulator. 
2. Select Edit >Phase Status.  
3. Select the appropriate phase from the Select Phase list. 
4. From the Arrays list, select Request Data Tags. Each request data tag 

associated with this phase is listed, along with its current value and 
type. 

 

Values of unit tags configured in the area model can be changed during run 
time in the Unit Tag Status dialog box. 

 
  

View request data tag 
values 

Unit Tag Status dialog box 
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The Unit Tag Status dialog box consists of the following: 

Item Definition 

Tagname A list of all configured unit tags for the active area model. 

Class The class associated with the unit tag. 
Type The type value associated with the unit tag. 
Item The item (addressable location) associated with the unit tag. 
Value The current value for the unit tag. This value can be modified and sent to the 

FactoryTalk Batch Server. 

Update Values Updates the tag values in the Simulator. 

 

Change the value of a unit tag using FactoryTalk Batch Phase Simulator. 

To change the value of a unit tag: 
1. Start the FactoryTalk Batch Phase Simulator. 
2. Select Edit > Unit Tag Status.  
3. Make any required modifications to the Unit Tag Values, and select 

Update Values. The new values are written into the FactoryTalk Batch 
Phase Simulator unit tags. 

4. Select OK to return to the FactoryTalk Batch Phase Simulator window. 
 

Change the value of a unit 
tag 
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Chapter 9 

Troubleshooting 

This section contains information on possible troubleshooting solutions for 
FactoryTalk eProcedure and the FactoryTalk Batch Server. 

 

 

This section contains information on eProcedure problems and possible 
work-arounds. 

 

 

By design, the eProcedure service does not look for embedded objects in the 
HTML template files. It simply passes that HTML code through to the Client 
and allows the browser to interpret it. There are two approaches that can be 
used to display objects embedded in the HTML code: 

• Put them in the default web share directory, which is the 
recommended approach for objects that would span multiple projects. 

OR 

• For project-specific objects, use the MMC (Internet Service Manager) 
to create a virtual directory that points to the \project\instructions 
directory. Security may be configured for this virtual directory such 
that it is read-only, without scripting or browsing privileges. (See 
Creating a virtual directory for more information.) 

Modify the template file to reference the object via the virtual directory. The 
path to the object will look something like: 
http://iis_name/virtualdirectory/object.ext. 

Tip: Make sure the object’s HTML code occurs within the Form tags in the instruction file. 

 

The following messages may be seen when attempting to reactivate a control 
step in the eProcedure Client Instructions View: 

Troubleshooting 
eProcedure 

Objects embedded in HTML 
code do not display 

Control step reactivation 
error messages 
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Cannot reactivate step 

 

Only past control steps that have not been reactivated, are in phases that are 
currently in the RUNNING state, and do not have any pending reactivated 
steps are eligible to be reactivated. 

Cannot remove batch 

 

If there are any incomplete Signature Requests pending for the batch, it 
cannot be removed from the batch list. Complete all Signature Requests and 
try again. 

Permission Denied 

If you do not have security permission to reactivate steps, you will see the 
"Permission denied to reactivate step" message. Another user with valid 
permission will have to reactivate the step. 

 

This section contains information on error log and tag verification log 
generation, and how these logs are used to troubleshoot system problems. 
This section also contains a list of specific error messages that may be 
encountered after installing and/or running FactoryTalk Batch, and possible 
troubleshooting solutions. 

 

In the event of a FactoryTalk Batch Server failure, FactoryTalk Batch allows 
you to restart your batches where they were before the failure. However, the 
ability to restart your batches may not be enough. If the reason for the Server 
failure is not something obvious, like a power failure, you will probably want 
to know the cause. If you need Rockwell's Application Support group to assist 
you with the determination, they need information regarding the Server’s 
status just prior to the failure. 

Troubleshooting 
FactoryTalk Batch 

Handle abnormal 
FactoryTalk Batch 
termination 
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The FactoryTalk Batch Server is designed to write this critical information to a 
log file. This file contains the information the Application Support group 
needs when determining the cause of a Server failure. However, the log file is 
a circular file, and eventually overwrites itself. To eliminate the possibility of 
losing this critical information, the Server copies the log file upon startup if it 
determines that the Server terminated abnormally. 

 

Upon startup, the FactoryTalk Batch Server reads the value of the 
AbnormalTermination field within the Batchsvr.ini file. If the field value is NO, 
or the field is not present, then no action is taken. If the field value is YES, 
then the current Batchsvr.log file is copied to the path specified by the 
ErrorLogDirectory entry in the Batchsvr.ini file. The name of the copied log file 
is determined based on the CopyFileID field. 

 

After determining whether or not to make a copy of the current log file, the 
FactoryTalk Batch Server writes a value of YES into the field. At completion of 
a normal shutdown, the Server writes a value of NO into the field. 

 

The value of the CopyFileID field is an integer from which a file name of the 
following format is generated: 

   <nnn>.LOG 

where <nnn> is the value of the CopyFileID field obtained from the 
Batchsvr.ini file, with leading zeros. The leading zeroes help sort the files when 
viewed from Windows Explorer or a similar program. Every time the 
FactoryTalk Batch Server uses this value to generate a name for a copied log 
file, it increments the integer value stored in the field. An attempt to 
increment the integer beyond a value of 999 results in a wrapping of the value 
back to one. 

If this value is not present or is invalid, then a current value of one (1) is 
assumed. This results in the creation of a log file copy with the name 001.log 
and the updating of the field to a value of two (2). 

If the FactoryTalk Batch Server generates a name for a copied log file, and the 
file name already exists in the directory where the copy is to be stored, the 
Server attempts to create a new name for the copied log file. The Server 
generates new log file names by incrementing the CopyFileID value until an 
unused file name is found. The integer used to generate this file name is 
incremented one last time and this value stored into the CopyFileID field in 
the Batchsvr.ini file. If no unused file names are found, then the Server is 
forced to overwrite the file name generated with the CopyFileID field’s 
original value. 

Determine abnormal 
termination 

Name the log file copy 
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The electronic batch record (.evt file) contains entries if the batch is 
terminated by a FactoryTalk Batch Server cold boot, or if the batch is 
terminated due to an error when attempting to restore the batch from a 
Server warm restart. 

The electronic batch record contains three entries if one of the above-
mentioned methods for batch termination occurs. The first entry is a repeat of 
the Event File Name event field. The second is a System Message event field 
indicating the reason the batch was terminated. The last is a System Message 
event field indicating the end of the batch. 

Example 

Termination of FactoryTalk Batch Due to Cold Boot 

Description Event PValue 

 Event File Name \\MachineName\Program Files\Rockwell 
Software\Batch\YourProject\ JOURNALS\4123.evt 

YourBatchDescription System Message Batch terminated by COLD boot of FactoryTalk Batch Server 

YourBatchDescription System Message End Of BATCH 

Termination of FactoryTalk Batch During Warm Restart 

Description Event PValue 

 Event File Name \\MachineName\Program Files\Rockwell 
Software\Batch\YourProject\ JOURNALS\4125.evt 

YourBatchDescription System Message Batch terminated due to error attempting to restore batch 
during WARM restart 

YourBatchDescription System Message End Of BATCH 
 
 
 

Tag verification is an operator-initiated process that causes the FactoryTalk 
Batch Server to attempt to read the current value of most tags defined in the 
area model. The tags are read up to 30 at a time, based on the value specified 
in the Batchsvr.ini file, and as reads are completed, new reads are initiated. 

The FactoryTalk Batch Server allows you to verify up to 30 tags in parallel to 
reduce tag verify duration and the ability to stop a tag verification in progress 
via a menu item on the Server. A dedicated log file, Verify.log, records the most 
recent tag verification results. This file is replaced with a new copy each time a 
tag verification is begun. The Verify.log file is written to the same directory as 
the Batchsvr.log file. 

End of batch entries 

Log tag verification 
information 
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Tag verification start, completion, and abort records are recorded in the 
standard FactoryTalk Batch Server log file, Batchsvr.log. Individual tag results 
are recorded in the tag verification log file, Verify.log. 

 

The record structure in the Verify.log file is identical to the record structure 
used in the Batchsvr.log file. The file structure reserves the first record for field 
labels. The installation program installs a default tag verify results log file into 
the directory specified by the ErrorLogDirectory value in the Batchsvr.ini file. 
The default file contains two records. The first record is the standard header 
record that labels the fields. The second record indicates if the tag verify 
function was performed. The format of this record is depicted below: 

Field# Name Value 

1 Time This field is left blank. 
2 Severity INFO 
3 File This field is left blank. 
4 Line This field is left blank. 
5 RC_ID This field is left blank. 
6 Batch ID This field is left blank. 
7 Path This field is left blank. 
8 Element ID This field is left blank. 
9 Element Name This field is left blank. 
10 Message The text "Tag Verify Has Not Been Run" 

The tag verification log file is not intended to wrap. In the event of an 
unexpected problem or circumstance, the Verify.log file is limited to 9,000,000 
bytes. If the Verify.log file exceeds this size, the file is wrapped, just like the 
Batchsvr.log file. 

An analysis of an existing tag verification log file showed that an area model 
with 888 tags generated a log file with a size of 159,050 bytes, which indicates 
an average of 180 bytes per tag in the verification log file. This implies that a 
9,000,000-byte file should be able to verify approximately 50,000 tags before 
the log file would wrap. 

The FactoryTalk Batch Server only keeps the tag verification log file open 
during the tag verification process. When a program has a file open, the file 
cannot be deleted or renamed. The Server overwrites any existing tag 
verification log file each time a tag verification begins. If the Server 
encounters a tag verification log file that is Read Only, the Server changes the 
protection on the file to allow it to be overwritten. 

 

The following events regarding tag verification are recorded in the Windows 
Event Log. 

Event Generated Windows Event Log 

Start "Batch Server Tag Verification Process Started" 

Tag verification log file 

Windows event log 
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Event Generated Windows Event Log 

Abort "Batch Server Tag Verification Process Aborted" 

Completion "Batch Server Tag Verification Completed, <xxx> of <yyy> tags verified successfully" 
where <xxx> is the number of tags that were successfully verified, and <yyy> is the 
total number of tags on which verification was attempted. 

 
 
 

The performance chart included with FactoryTalk Batch is a pre-defined set of 
charts for use with the Windows System Monitor. 

Tip: The predefined performance monitor charts are in English only. Non-English 
customers must configure the charts manually. (Refer to your Windows 
documentation for more information on performance charts.) 

The System Monitor can examine the use of computer resources by 
FactoryTalk Batch components, as well as other processes and applications, 
and it can help determine if a process or application is using too much CPU 
time or memory. The pre-defined Performance Chart, supplied with 
FactoryTalk Batch, charts specific processes that can affect the performance of 
FactoryTalk Batch, and can be an important tool in identifying and 
troubleshooting system problems. 

Tip: The performance chart is intended to be used primarily as a debugging and 
diagnostic tool by FactoryTalk Batch product support personnel. 

The Windows System Monitor is used to view chart data, alerts, logs and 
reports. Additionally, charts can be saved for future review. To view the 
FactoryTalk Batch performance chart, make sure that the System Monitor is 
set to chart view mode. (Refer to your Windows documentation for more 
information on using the System Monitor.) 

 

The performance chart automatically opens the Windows System Monitor 
with the pre-defined charts loaded. 

To open the FactoryTalk Batch performance chart: 
1. Select Start > Rockwell Software > FactoryTalk Batch Suite > 

FactoryTalk Batch. 
2. Click Performance Chart. The Performance dialog box opens with the 

pre-defined charts listed. 
  

Performance chart 

Open the FactoryTalk Batch 
performance chart 



Chapter 9  Troubleshooting 
 

  95 
 

The FactoryTalk Batch performance chart is a pre-defined set of charts for use 
with the Windows System Monitor. 

 
Tip: The predefined performance monitor charts are in English only. Non-English customers must 
configure the charts manually. (Refer to your Windows documentation for more information on 
performance charts.) 

The Windows System Monitor can examine the use of computer resources by 
FactoryTalk Batch components, as well as other processes and applications, 
and help determine if a process or application is using too much CPU time or 
memory. The performance chart charts specific processes that can affect the 
performance of FactoryTalk Batch, and is an important tool in identifying and 
troubleshooting system problems. 

 
Tip: The performance chart is intended to be used primarily as a debugging and diagnostic tool by 
FactoryTalk Batch product support personnel. 

The Windows System Monitor is used to view chart data, alerts, logs and 
reports. Additionally, charts can be saved for future review. To view the 
FactoryTalk Batch performance chart, make sure that the System Monitor is 
set to chart view mode.  

 

This section outlines errors that may be encountered while running 
FactoryTalk Batch and possible solutions to these errors. 

Automatic repair of Batch component installation fails 

This can happen if one or more necessary folders were unintentionally moved 
(in Windows explorer). For example, if the Schema folder gets moved away 
from its original install path, the install package starts up automatically and 
tries to ‘repair’ the problem. This ‘repair’ can clear out the Model and Server 
keys in the registry, which can make the Batch client editors generate warning 
dialogs because they are not able to find the Network Model. 

If this happens, completely uninstall the application and then reinstall it. 

FactoryTalk Batch Server does not start 

Error Message: (none) 

• Journal path has not been defined in FactoryTalk Batch Server options. 

Modify the FactoryTalk Batch Server options to include a valid Primary 
Journal path. Verify that the Secondary Journal path, if defined, is 
valid. 

• Restart path has not been defined in FactoryTalk Batch Server options. 

FactoryTalk Batch 
performance chart 

Troubleshoot errors 
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Modify the FactoryTalk Batch Server options to include a valid Primary 
Restart path. Verify that the Secondary Restart path, if defined, is 
valid. 

• Incorrect Net registry key value. 

The FactoryTalk Batch Server is always installed with the default user 
and password. 
The FactoryTalk Batch Server’s logon/password settings are not 
migrated from the Server .ini file during an upgrade. To run the Server 
as a different user, you must change the logon/password settings, 
using the Control Panel Services dialog box, after a new installation. 

FactoryTalk Batch Server runs for a specific period of time and then 
stops, and consistently stops at the same time interval. 

Error Message: (none) 

• Check the FactoryTalk Batch Service Manager. If the Allow Demo 
Mode check box is selected, this could be the problem. 

FactoryTalk Batch Service Manager does not display the FactoryTalk 
Batch Server and/or Event Archiver.  

Error Message: (none) 

• The computer where the services are located is not selected. 

Use the Select Computer button to select the appropriate computer. 

• The FactoryTalk Batch Server and/or Archiver services are not 
registered with the Windows Registry. 

To register a service, click the Start button, point to All Programs, and 
then select Command Prompt. Navigate to the Program Files\Rockwell 
Software\Batch\bin directory. To register the FactoryTalk Batch Server 
type batchsrv /service at the command prompt, and then press enter. 
To register the FactoryTalk Event Archiver, type batcharc /service at 
the command prompt, and then press enter. 

FactoryTalk Batch Service Manager displays "Batch.Server Class" 
instead of "Batch Server". 

Error Message: (none) 

• The service displays the class name instead of the display name. 
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This is caused by DCOMCNFG configuring the FactoryTalk Batch 
Server service to display the class name of the service instead of the 
display name. When this occurs, the Server no longer supports its 
COM interface and must be reinstalled. 

The FactoryTalk Batch View/Client is properly configured, but can’t 
view the Event Journals. 

Error Message: (none) 

• There may be a version conflict in one or more of the required files. 

The text in FactoryTalk Batch dialog boxes does not display 
properly. 

Error Message: (none) 

• FactoryTalk Batch does not support the use of large system fonts. 

Use the Display Properties dialog box to change the default system 
font size to Small Fonts. 

Unable to locate files. 

Error Message: "The Recipe directory file could not be found." 

• The server options for the FactoryTalk Batch Server are not configured 
to point to the folder that contains the Recipe.dir file. (See FactoryTalk 
Batch Server option configuration in the FactoryTalk Batch 
Administrator Guide for more information.) 

An Application Log error is generated. 

Error Message: "The Application log file is full." 

• The Application log is not set for wrapping. 

Use the Event Viewer to change the Application Event Log Wrapping setting 
to Overwrite Events as Needed: 

1. Click the Start button, point to All Programs > Administrative Tools, 
and then select Event Viewer. The Event Viewer opens. 

2. Right-click Application Log, and select Properties. The Application 
Log Properties dialog box opens. 

3. In the Log size section, select Overwrite events as needed. 
4. Click OK. 
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5. Exit the Event Viewer. 

A Licensing error message is generated in Microsoft Visual Basic. 

Error Message: "License information for this component not found. You do 
not have an appropriate license to use this functionality in the design 
environment." 

• The ActiveX controls did not install correctly. 

Visual Basic should be installed before FactoryTalk Batch is installed. If you 
have already installed FactoryTalk Batch: 

1. Uninstall the FactoryTalk Batch client to remove the ActiveX controls. 
(Refer to the FactoryTalk Batch Components Upgrade and Installation 
Guide for information on removing the ActiveX Controls). 

2. Re-install Visual Basic. 
3. Re-install the FactoryTalk Batch client using the FactoryTalk Batch 

Setup program. 

Recipes not visible from FactoryTalk Batch View program. 

Error Message: (none) 

• When the Create a Batch button is clicked, no recipes show up in the 
Select a Recipe dialog box. 

The Released to Production item is not selected in the recipe header 
data. For each recipe that should appear in the Select a Recipe dialog 
box, ensure that the Released to Production check box is selected. This 
can be done by selecting the Header data option for the recipe and 
selecting the Released to Production check box. 

List of available SQL Server databases not displayed in the Server 
Options dialog box. 

Error Message: (none) 

When the browse button for SQL Server databases is clicked, no 
databases are displayed in the Database Selection dialog box. 
Install SQL Server’s ClientTools Connectivity option. Do a custom 
installation of SQL Server to install the Client Tools Connectivity 
option. 
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Event Journal files are not being created. 

Error Message: (none) 

• The primary journal directory must be located on the FactoryTalk 
Batch Server computer in the BATCHCTL share. If the Primary 
Journals directory is located on a computer other than the Server 
computer, or not within the BATCHCTL share, and that computer 
becomes inaccessible, the Server continues executing batches but is 
unable to create event journals for those batches. You will not receive a 
notification of the problem. 
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Chapter 10 

Customize batch IDs 

For purposes of batch identification, you can create custom default batch IDs, 
and allow or prevent editing of batch IDs. You can also automatically generate 
custom batch IDs. In order to implement this option, you must perform steps 
in the FactoryTalk Batch View and the FactoryTalk Batch Equipment Editor, 
edit some Visual Basic code (provided with your FactoryTalk Batch 
installation CD) and compile it into a new DLL. If you are using the 
FactoryTalk Batch ActiveX controls, you can use the BatchID editable property 
to enable or disable editing of batch IDs. (See the FactoryTalk Batch ActiveX 
Controls Library Reference for more information.) 

By default, eProcedure allows editing of batch IDs. However, you can modify 
the user.asp file to disable editing of batch IDs; or to re-enable editing batch 
IDs if it was disabled. (See "Modifying the user.asp file to prevent editing of 
batch IDs" on page 105 and "Modifying the user.asp file to allow editing of 
batch IDs" on page 104.) 

 

 

The batch ID is shown on the Batch Creation dialog box when a batch is 
created, and by default, is editable. However, if editing of batch IDs has been 
disabled, follow these steps to enable this option. 

1. Open the FactoryTalk Batch View. 
2. Click the Configuration and Defaults button. 
3. Enter your system configuration password, and then click OK. 
4. Select the General tab, and in the BatchID Editing area, select the 

Allow Editing of Batch ID check box. 

 
  

Enable editing of batch IDs 
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If you create a custom batch ID, we recommend that you prevent editing of 
batch IDs. This ensures that the custom batch ID you specified appears when 
you add a batch to the batch list, and that it cannot be changed by the 
operator. 

The following steps disable editing of the batch ID. In this case, the box on the 
Batch Creation dialog, which displays when a batch is added to the batch list, 
is grayed out. 

Tip: If a failure occurs in the generation of a custom batch ID, the batch ID is 
editable regardless of the setting. 

1. Perform steps 1-3 in the previous section, "Enable Editing of Batch 
IDs." 

2. Click the General tab, and then in the BatchID Editing section, 
deselect the Allow Editing of Batch ID check box. 

 
 

If you define a custom default batch ID, when a new batch is added to the 
batch list, the box on the Batch Creation dialog is automatically populated 
with the custom default batch ID.  

To define a custom default batch ID:  
1. Open the FactoryTalk Batch Equipment Editor. 
2. From the Options menu, select Server Options. 
3. Select the Batch Server tab. 
4. In the Miscellaneous section, type a default batch ID in the Default 

Batch ID box. 

 
5. Select OK. 
 
 

The option to automatically generate custom batch IDs, in any values or 
increments you require, is easily implemented. If you choose this option, you 
must modify some Visual Basic code, compile it into a new DLL (Dynamic 
Link Library) file and then place it in the BATCHCTL\Bin folder. We 

Disable editing of batch IDs 

Define a custom default 
batch ID 

Create a custom 
BatchIDCreation.dll 
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recommend that you make a back up copy of the original BatchIDCreation.dll 
before making any changes. The currently supported version of Visual Basic is 
shown in the System Requirements of the FactoryTalk Batch Getting Results Guide. 

Tip: The FactoryTalk Batch Server and the Visual Basic development environment 
must be installed on the same computer. 

 

Tip: If the AutoBatchID execute fails or the generated batch ID contains invalid 
characters, the Batch ID box in the FactoryTalk Batch View becomes 
editable even if the Allow Editing of Batch ID check box in the 
View/Configuration and Defaults/General is disabled. If you created a 
default batch ID, it populates the Batch ID box and is editable. This 
feature allows the operator to enter the batch ID manually in the event of 
a failure. 

To customize the DLL: 
1. Copy the entire Custom folder, found on the FactoryTalk Batch CD, 

including all subdirectories, to the local hard drive, leaving the 
structure intact. 

2. Double-click BatchIDCreation.vbp. The Visual Basic project opens. If you 
see error messages about references that are not yet in the Visual Basic 
project, click Yes until you see the message that Visual Basic is unable 
to set the version compatible component. Click OK. 

3. From the Project menu, select References. The References dialog box 
opens. 

There are several files that are required for references used in the 
Visual Basic project. These references must be set manually within the 
Visual Basic IDE. 

4. From the Available References list, select the following references: 

• COM+ Services Type Library 
The COM+ Runtime library, COMSVCS.dll, that is needed for COM+ 
functionality. If this file is not on your system use MTXAS.dll. 

• OLE Automation 
The OLE Automation support DLL, STDOLE32.tlb, which is usually a 
standard Visual Basic reference. 

• batchidcreationinsertion 1.0 Type Library 
The AutoBatchID type library, batchidcreationinsertion.tlb, 
required to create your customized version of the 
BatchIDCreation.dll. 

5. Click OK. 
6. From the Project menu, select BatchIDCreation Properties. The 

Project Properties dialog box opens. 
7. Select the Component tab, and then select Binary Compatibility. 
8. Click the browse button, locate C:\\Program Files\\Rockwell 

Software\\Batch\Bin\BatchIDCreation.dll, and then click Open. 
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9. Click OK. 
10. Modify the source code located between the Begin - Code 

Modifications heading and the End - Code Modifications heading 
within [GenerateBatch] to define the BatchID value. 
Tip: The batch ID can contain a maximum of 255 characters with no spaces or invalid 

characters. The batch ID can be comprised of any characters except the following: The 
defined list separator, single or double quotes, brackets, parentheses, the percent sign (%), 
the tab character ( \t ), the carriage return character ( \r ), or the new line character ( \n ). 

11. From the File menu, click Make BatchIDCreation.dll. The Make 
Project dialog box opens. Compile the project into a .dll named 
BatchIDCreation dll. 

12. Click OK. 
13. Replace the default BatchIDCreation.dll in the BATCHCTL\Bin folder 

with the newly compiled BatchIDCreation.dll. 
14. Restart your computer. 
 
 

In order for eProcedure to allow editing of batch IDs you must modify the 
user.asp file. 

1. Open Windows Explorer. 
2. Navigate to C:\\Program Files\\Rockwell Software\\Batch\Web. 
3. Open the user.asp file using Notepad or the Editor of your choice. 

 
4. Set the following value to true: 

<% const blnBatchIDEditable = true 
5. Save the user.asp file. 
6. Exit Notepad or the Editor you are using. 

Modify the user.asp file to 
allow editing of batch IDs 
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7. You must close and then restart the eProcedure Client for the change 
to take effect. 

 
 

In order to prevent editing batch IDs you must modify the user.asp file. 

1. Open Windows Explorer. 
2. Navigate to C:\\Program Files\\Rockwell Software\\Batch\Web. 
3. Open the user.asp file using Notepad or the Editor of your choice. 
4. Set the following value to false: 

<% const blnBatchIDEditable = false 
5. Save the user.asp file. 
6. Exit Notepad or the Editor you are using. 
7. You must close and then restart the eProcedure Client for the change 

to take effect. 
 

Modify the user.asp file to 
prevent editing of batch IDs 
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Chapter 11 

Archive HTML elements 

The archived HTML represents the completed control step as the operator saw 
it when it completed, and includes any data entered by the operator. When an 
eProcedure user completes a control step, the eProcedure Client captures the 
step’s HTML. Client-side scripting removes any script blocks the step may 
contain and disables all dynamic elements in the step. The eProcedure Client 
then sends the instructions to the eProcedure Server, which sends the step 
HTML to the FactoryTalk Batch Server. The FactoryTalk Batch Server then 
writes the step HTML to the event journal as part of an Instruction Complete 
event. 

Script Blocks 

Before sending control step HTML to the eProcedure Server, the eProcedure 
Client removes all script blocks, and disables all buttons, text boxes, and other 
dynamic HTML elements the step contains. For example, before being 
sanitized, the HTML for a step may look like the following: 

<FORM> 

<INPUT type=button value="Click This Button" 
onclick=ButtonClick> 

<INPUT type=text value="Kilroy Was Here"> 

<IMG src=./images/Image.JPG onclick='msgbox 
"Hello!"'> 

<SCRIPT language=vbscript> 

sub ButtonClick 

window.alert "Hi There" 

end sub 

</SCRIPT> 

</FORM> 

After sanitization, the HTML looks like this: 

<FORM> 

<INPUT type=button value="Click This Button" 
onclick=ButtonClick disabled> 

<INPUT type=text value="Kilroy Was Here" disabled> 

<IMG src=./images/Image.JPG onclick='msgbox "Hello!"' 
disabled> 

</FORM> 

 
Tip: Images and files must be placed in directories under \Batch\web\ to use relative 

("./") paths. Otherwise, absolute path names must be used (for example, 
"/full_path/Image.jpg"). 
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OBJECT Elements 

In HTML stored in the event journal, <OBJECT> elements are removed and 
are replaced with a message. Before sending control step HTML to the 
eProcedure Server, the eProcedure Client removes all <OBJECT> elements and 
their child elements the step contains and replaces them with the message 
"Note: Object Removed For Archiving" and the class ID of the removed object. 
For example, the HTML for a step may look like this: 

<FORM> 

Add a CIP Batch to the Batch List. Click "OK" when 
done."&nbsp;" 

<OBJECT classid=clsid:29DAC4FF-034F-11D3-91DE-
0800366B4903 

codeBase=./components/batchv01.cab height=100% 

id=crl name=crl style="POSITION: relative" 
width=100%> 

<PARAM NAME="Node" VALUE="DEV_CLCASE02"> 

</OBJECT> 

</FORM> 

After sanitization, removing the object element and its child element, and 
inserting the message, the HTML would look like this: 

<FORM> 

Add a CIP Batch to the Batch List. Click "OK" when 
done."&nbsp;" 

<I>Note: Object clsid:29DAC4FF-034F-11D3-91DE-
0800366B4903 Removed for Archiving</I> 

</FORM> 

TAB Characters and CRLFs 

Before sending control step HTML to the eProcedure Server, the eProcedure 
Client removes all TAB characters and CRLFs and replaces them with spaces. 
As the event journal is a TAB-delimited document, and individual records are 
separated by CRLFs, this prevents corruption of the data stored in the file. 
This does not change the way HTML is rendered. 

List Separator Characters, Parentheses, and Forward Slashes 

List separator characters, parentheses, and forward slashes (/) will not be 
removed from archived instructions. 

HTML Placeholder 

The eProcedure Server adds a hidden input element called "StepHTML" to all 
active control steps. This is used by the eProcedure Client as a placeholder for 
step HTML before step submission. When you view the source code of an 
active instruction, the input element resembles the following: <input 
type=hidden name=StepHTML id=StepHTML> 
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After sanitizing the instructions, the control step HTML is stored in this 
element. Server-side scripting will extract the HTML from this element and 
send it to the eProcedure Server. 

 

The following list defines HTML elements that can be contained in an 
instruction step, can be dynamic and therefore must be disabled before 
archiving. (Source: MSDN Library. See the MSDN library for documentation as 
to the types of events that can be defined for each element.) 

Name Description 

a Designates the start or destination of a hypertext link. 

acronym Indicates an acronym abbreviation. 
address Specifies information, such as address, signature, and authorship, of the current 

document. 

applet Places executable content on the page. 

area Defines the shape, coordinates, and associated URL of one hyperlink region within 
a client-side image map. 

b Specifies that the text should be rendered in bold. 

Base Specifies an explicit URL used to resolve links and references to external sources 
such as images and style sheets. 

baseFont Sets a base font value to be used as the default font when rendering text. 

bdo Allows authors to disable the bidirectional algorithm for selected fragments of 
text. 

bgSound Enables an author to create pages with background sounds or sound tracks. 

big Specifies that the enclosed text should be displayed in a larger font than the 
current font. 

blockQuote Sets apart a quotation in text. 

Body Specifies the beginning and end of the document body. 
br Inserts a line break. 
button Specifies a container for rich HTML that is rendered as a button. 
caption Specifies a brief description for a table. 
center Centers subsequent text and images. 
cite Indicates a citation by rendering text in italic. 
Code Specifies a code sample. 
col Specifies column-based defaults for the table properties. 
colGroup Specifies property defaults for a column or group of columns in a table. 
comment Indicates a comment that is not displayed. 
custom Represents a user-defined element. 
dd Indicates the definition in a definition list. The definition is usually indented in the 

definition list. 

del Indicates text that has been deleted from the document. 

dfn Indicates the defining instance of a term. 
dir Denotes a directory list. 
div Specifies a container that renders HTML. 
Dl Denotes a definition list. 
Dt Indicates a definition term within a definition list. 

HTML elements 



Chapter 11  Archive HTML elements 
 

110   
 

Name Description 

em Emphasizes text, usually by rendering it in italic. 
embed Allows documents of any type to be embedded. 
fieldSet Draws a box around the text and other elements that the field set contains. 
font Specifies a new font, size, and color to be used for rendering the enclosed text. 

frame Specifies an individual frame within a FRAMESET element. 

frameSet Specifies a frameset, which is used to organize multiple frames and nested 
framesets. 

Head Provides an unordered collection of information about the document. 
hn Renders text in heading style. 
hr Draws a horizontal rule. 
html Identifies the document as containing HTML elements. 
i Specifies that the text should be rendered in italic, where available. 
iframe Creates inline floating frames. 
img Embeds an image or a video clip in the document. 
Input Creates a variety of form input controls. 
Input type=button Creates a button control. 
Input type=check box Creates a check box control. 
Input type=file Creates a file upload object with a text box and Browse button. 
input type=image Creates an image control that, when clicked, causes the form to be immediately 

submitted. 
input type=password Creates a single-line text entry control similar to the INPUT type=text control, 

except that text is not displayed as the user enters it. 
input type=radio Creates a radio button control. 

input type=reset Creates a button that, when clicked, resets the form's controls to their initial 
values. 

input type=submit Creates a button that, when clicked, submits the form. 

input type=text Creates a single-line text entry control. 
ins Specifies text that has been inserted into the document. 
isIndex Causes the browser to display a dialog window that prompts the user for a single 

line of input. 
kbd Renders text in a fixed-width font. 
label Specifies a label for another element on the page. 
legend Inserts a caption into the box drawn by the fieldSet object. 
li Denotes one item in a list. 
link Enables the current document to establish links to external documents. 
listing Renders text in a fixed-width font. 
map Contains coordinate data for client-side image maps. 
marquee Creates a scrolling text marquee. 
menu Creates an unordered list of items. 
meta Conveys hidden information about the document to the server and the client. 

noBR Renders text without line breaks. 

noFrames Contains HTML for browsers that do not support FRAMESET elements. 
noScript Specifies HTML to be displayed in browsers that do not support scripting. 
object Inserts an object into the HTML page. 
ol Draws lines of text as a numbered list. 
optGroup Allows authors to group choices logically in a select element. 
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Name Description 

option Denotes one choice in a SELECT element. 
p Denotes a paragraph. 
plainText Renders text in a fixed-width font without processing tags. 
pre Renders text in a fixed-width font. 
q Sets apart a quotation in text. 
rt Designates the ruby text for the RUBY element. 
ruby Designates an annotation or pronunciation guide to be placed above or inline with 

a string of text. 

s Renders text in strike-through type. 

samp Specifies a code sample. 
script Specifies a script for the page that is interpreted by a script engine. 
select Denotes a list box or drop-down list. 
small Specifies that the enclosed text should be displayed in a smaller font. 
span Specifies an inline text container. 
strike Renders text in strike-through type. 
strong Renders text in bold. 
style Specifies a style sheet for the page. 
sub Specifies that the enclosed text should be displayed in subscript, using a smaller 

font than the current font. 

sup Specifies that the enclosed text should be displayed in superscript, using a smaller 
font than the current font. 

table Specifies that the contained content is organized into a table with rows and 
columns. 

tBody Designates rows as the body of the table. 

td Specifies a cell in a table. 
textArea Specifies a multiline text input control. 
tFoot Designates rows as the table's footer. 
th Specifies a header column. Header columns are centered within the cell and are 

bold. 
tHead Designates rows as the table's header. 

title Contains the title of the document. 
tr Specifies a row in a table. 
tt Renders text in a fixed-width font. 
u Renders text that is underlined. 
ul Draws lines of text as a bulleted list. 
var Defines a programming variable. Typically renders in an italic font style. 
xmp Renders text used for examples in a fixed-width font. 
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Chapter 12 

Change the FactoryTalk Batch server user 
account 

Depending on your facility’s security requirements you may need to change 
the FactoryTalk Batch server user name and password periodically. If you 
change the server’s user account after installing the FactoryTalk Batch 
components you must configure your FactoryTalk Batch system to use the 
new server user account. 

 
Tip: The user account for the FactoryTalk Batch server, Batch Archiver, eProcedure server services 
and the Batch COM+ Application must be identical. 

 

When creating a new user account for the FactoryTalk Batch Server, the 
following requirements must be met. 

• The password must be configured never to expire--if the password ever 
expires, the service eventually fails to log on. 

• The user account must never be disabled or deleted--if this account is 
ever disabled/deleted, the service eventually fails to log on. 

• The domain user account must have a unique name--if the user 
account is a domain account, remove any local user accounts with the 
same name. 

• The user account/user group must exist on all workgroup computers--
if you want a local account to have access to resources on other 
computers in a workgroup environment, you must create accounts 
with the same name and password on each computer in the 
workgroup.  

 
 

After you create a new user account for the FactoryTalk Batch Server, 
configure your FactoryTalk Batch system. 

To configure your FactoryTalk Batch system 
1. Configure the FactoryTalk Batch Server computer: 

a. Add the new server user account to the batchsvr_group and 
administrators group. By adding the new account to the 

New user account 
requirements for the 
FactoryTalk Batch Server 

Configure your FactoryTalk 
Batch system 
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batchsvr_group it inherits all the required user rights and access 
permissions. 

b. If FactoryTalk Batch Material Manager is part of your system, add 
the new FactoryTalk Batch Server user account to the 
MTBatchServer group on the Material Server computer. 

c. Add the new FactoryTalk Batch Server user account to the 
FactoryTalk Batch Server service.  

d. If you are running FactoryTalk Event Archiver in incremental mode, 
add the new FactoryTalk Batch Server user account in the Batch 
Archiver service. 

e. If FactoryTalk eProcedure is part of your system, add the new 
FactoryTalk Batch Server user account to the eProcedure Server 
service. 

f. Add the new FactoryTalk Batch Server user account to the Batch 
COM object in Component Services > My Computer > COM+ 
Applications.  

2. Configure the FactoryTalk Batch Client computer(s): 

a. If you are using workgroup security, create the new FactoryTalk Batch 
Server user account on all FactoryTalk Batch Client computers in the 
workgroup. 

b. Add the new FactoryTalk Batch Server user account to Component 
Services > My Computer > Properties > COM Security on all remote 
FactoryTalk Batch View computers. Configure the account with 
Access Permissions: Local Access and Remote Access.  

c. If eProcedure is part of your system, add the new FactoryTalk Batch 
Server user account to Component Services > My Computer > 
Properties > COM Security on all remote eProcedure Client 
computers. Configure the account with Access Permissions: Local 
Access and Remote Access.  

 

If you change the password for the existing FactoryTalk Batch Server user 
account, change the password in these locations: 

• If you are using Workgroup security, change the password for the 
FactoryTalk Batch Server user account on all FactoryTalk Batch 
computers in the workgroup. 

• Change the password for the FactoryTalk Batch Server user account in 
the FactoryTalk Batch server service.  

Change the server account 
password 
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• If you are running FactoryTalk Event Archiver in incremental mode, 
change the password for the FactoryTalk Batch Server user account 
to the Batch Archiver service. 

• If eProcedure is part of your system, change the password for the 
FactoryTalk Batch Server user account in the eProcedure Server 
service. 

• Change the password for the FactoryTalk Batch Server account in the 
Batch COM object in Component Services > My Computer > COM+ 
Applications.  

 

To change the user account for the FactoryTalk Batch Server service, complete 
these steps on the server computer. 

To change the server user account for the FactoryTalk Batch Server 
service 

1. Select Start > Windows Administrative Tools > Services. The Services 
dialog box opens. 

2. Right-click FactoryTalk Batch Server, and then click Properties. The 
FactoryTalk Batch Server Properties dialog box opens. 

3. On the Log On tab, select This Account and type the new user and/or 
password. 

4. Click OK. 

• If you are using FactoryTalk Event Archiver in incremental mode, 
change the user account name and/or password for the Batch 
Archiver service. 

• If eProcedure is part of your system, change the user account name 
and/or password for the eProcedure Server service. 

5. Close Services. 

 
  

Change the server user 
account for the FactoryTalk 
Batch Server service 
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To change the FactoryTalk Batch Server user account in Batch COM+ 
applications, complete these steps on the FactoryTalk Batch Server computer. 

To change the server user account in FactoryTalk Batch COM+ 
applications 

1. Select Start > Windows Administrative Tools > Component Services. 
2. Expand Component Services, Computers, My Computer and COM+ 

Applications. 
3. Right-click Batch, and then select Properties. The Batch Properties 

dialog box opens. 
4. On the Identity tab, select This user and type the new FactoryTalk 

Batch Server user name and/or password. 
5. Click OK. 

 
Tip: The new permissions are applied the next time the FactoryTalk Batch Server is started 
on the computer. 

 

To change the FactoryTalk Batch Server user account in My Computer 
properties, complete these steps on the FactoryTalk Batch Client computers. 

To change the server user account in My Computer properties 
1. Select Start > Windows Administrative Tools > Component Services. 
2. Expand Component Services and Computers. 
3. Right-click My Computer, and then click Properties. The My 

Computer Properties dialog box opens. 
4. On the COM Security tab, click the Edit Default button in the Access 

Permissions area. The Access Permission dialog box opens. 
5. Click the Add button to open the Select Users, Computers, or Groups 

dialog box. 
6. Type the new FactoryTalk Batch Server user account name and then 

click OK. 
7. In the Access Permission dialog box, select the new FactoryTalk Batch 

Server account. In the Permissions list, select Allow for Local Access 
and Remote Access. 

8. Click OK twice. 
9. Close Component Services. 
10. Restart the computer. 

Change the server user 
account in FactoryTalk 
Batch COM+ applications  

Change the server user 
account in My Computer 
properties 
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After you create a new user account for the FactoryTalk Batch Server, 
configure your FactoryTalk Batch system. 

To configure your FactoryTalk Batch system 
1. Configure the FactoryTalk Batch Server computer: 

a. Add the new server user account to the batchsvr_group and 
administrators group. By adding the new account to the 
batchsvr_group it inherits all the required user rights and access 
permissions. 

b. If FactoryTalk Batch Material Manager is part of your system, add 
the new FactoryTalk Batch Server user account to the 
MTBatchServer group on the Material Server computer. 

c. Add the new FactoryTalk Batch Server user account to the 
FactoryTalk Batch Server service.  

d. If you are running FactoryTalk Event Archiver in incremental mode, 
add the new FactoryTalk Batch Server user account in the Batch 
Archiver service. 

e. If FactoryTalk eProcedure is part of your system, add the new 
FactoryTalk Batch Server user account to the eProcedure Server 
service. 

f. Add the new FactoryTalk Batch Server user account to the Batch 
COM object in Component Services > My Computer > COM+ 
Applications.  

2. Configure the FactoryTalk Batch Client computer(s): 

a. If you are using workgroup security, create the new FactoryTalk Batch 
Server user account on all FactoryTalk Batch Client computers in the 
workgroup. 

b. Add the new FactoryTalk Batch Server user account to Component 
Services > My Computer > Properties > COM Security on all remote 
FactoryTalk Batch View computers. Configure the account with 
Access Permissions: Local Access and Remote Access.  

c. If eProcedure is part of your system, add the new FactoryTalk Batch 
Server user account to Component Services > My Computer > 
Properties > COM Security on all remote eProcedure Client 
computers. Configure the account with Access Permissions: Local 
Access and Remote Access.  

  

Configure your FactoryTalk 
Batch system 
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If you change the password for the existing FactoryTalk Batch Server user 
account, change the password in these locations: 

• If you are using Workgroup security, change the password for the 
FactoryTalk Batch Server user account on all FactoryTalk Batch 
computers in the workgroup. 

• Change the password for the FactoryTalk Batch Server user account in 
the FactoryTalk Batch server service.  

• If you are running FactoryTalk Event Archiver in incremental mode, 
change the password for the FactoryTalk Batch Server user account 
to the Batch Archiver service. 

• If eProcedure is part of your system, change the password for the 
FactoryTalk Batch Server user account in the eProcedure Server 
service. 

• Change the password for the FactoryTalk Batch Server account in the 
Batch COM object in Component Services > My Computer > COM+ 
Applications.  
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Literature Library Find installation instructions, manuals, brochures, and technical data publications. rok.auto/literature 
Product Compatibility and Download Center 
(PCDC) 
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